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Garantie 2
Tektronix garantiert, dass dieses Produkt für einen Zeitraum von einem (1) Jahr ab Versanddatum keine Fehler in Material und
Verarbeitung aufweist. Wenn ein Produkt innerhalb dieser Garantiezeit Fehler aufweist, steht es Tektronix frei, dieses fehlerhafte
Produkt kostenlos zu reparieren oder einen Ersatz für dieses fehlerhafte Produkt zur Verfügung zu stellen. Von Tektronix für
Garantiezwecke verwendete Teile, Module und Ersatzprodukte können neu oder in ihrer Leistung neuwertig sein. Alle ersetzten
Teile, Module und Produkte werden Eigentum von Tektronix.

Um mit dieser Garantie Kundendienst zu erhalten, muss der Kunde Tektronix über den Fehler vor Ablauf der Garantiezeit informieren
und geeignete Vorkehrungen für die Durchführung des Kundendienstes treffen. Der Kunde ist für die Verpackung und den Versand
des fehlerhaften Produkts an die Service-Stelle von Tektronix verantwortlich, die Versandgebühren müssen im Voraus bezahlt sein.
Tektronix übernimmt die Kosten der Rücksendung des Produkts an den Kunden, wenn sich die Versandadresse innerhalb des Landes
der Tektronix Service-Stelle befindet. Der Kunde übernimmt alle Versandkosten, Fracht- und Zollgebühren sowie sonstige Kosten
für die Rücksendung des Produkts an eine andere Adresse.

Diese Garantie tritt nicht in Kraft, wenn Fehler, Versagen oder Schaden auf die falsche Verwendung oder unsachgemäße und falsche
Wartung oder Pflege zurückzuführen sind. Tektronix muss keinen Kundendienst leisten, wenn a) ein Schaden behoben werden
soll, der durch die Installation, Reparatur oder Wartung des Produkts von anderem Personal als Tektronix-Vertretern verursacht
wurde; b) ein Schaden behoben werden soll, der auf die unsachgemäße Verwendung oder den Anschluss an inkompatible Geräte
zurückzuführen ist; c) Schäden oder Fehler behoben werden sollen, die auf die Verwendung von Komponenten zurückzuführen sind,
die nicht von Tektronix stammen; oder d) wenn ein Produkt gewartet werden soll, an dem Änderungen vorgenommen wurden oder
das in andere Produkte integriert wurde, so dass dadurch die aufzuwendende Zeit für den Kundendienst oder die Schwierigkeit der
Produktwartung erhöht wird.

DIESE GARANTIE WIRD VON TEKTRONIX FÜR DAS PRODUKT ANSTELLE ANDERER AUSDRÜCKLICHER ODER IMPLIZITER
GARANTIEN GEGEBEN. TEKTRONIX UND SEINE HÄNDLER SCHLIESSEN AUSDRÜCKLICH ALLE GARANTIEN HINSICHTLICH
DER HANDELSGÄNGIGKEIT UND DER EIGNUNG FÜR EINEN BESTIMMTEN ZWECK AUS. FÜR TEKTRONIX BESTEHT DIE
EINZIGE UND AUSSCHLIESSLICHE VERPFLICHTUNG DIESER GARANTIE DARIN, FEHLERHAFTE PRODUKTE FÜR DEN
KUNDEN ZU REPARIEREN ODER ZU ERSETZEN. TEKTRONIX UND SEINE HÄNDLER ÜBERNEHMEN KEINERLEI HAFTUNG
FÜR DIREKTE, INDIREKTE, BESONDERE UND FOLGESCHÄDEN, UNABHÄNGIG DAVON, OB TEKTRONIX ODER DER
HÄNDLER VON DER MÖGLICHKEIT SOLCHER SCHÄDEN IM VORAUS UNTERRICHTET IST.
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Allgemeine Sicherheitshinweise

Allgemeine Sicherheitshinweise
Beachten Sie zum Schutz vor Verletzungen und zur Verhinderung von Schäden an diesem Gerät oder an damit verbundenen
Geräten die folgenden Sicherheitshinweise.

Verwenden Sie dieses Gerät nur gemäß der Spezifikation, um jede mögliche Gefährdung auszuschließen.

Wartungsarbeiten sind nur von qualifiziertem Personal durchzuführen.

Während der Verwendung des Geräts müssen Sie eventuell auf andere Teile eines umfassenderen Systems zugreifen.
Beachten Sie die Sicherheitsangaben in Handbüchern für andere Komponenten bezüglich Warn- und Vorsichtshinweisen
zum Betrieb des Systems.

Verhütung von Bränden und Verletzungen
Verwenden Sie ein ordnungsgemäßes Netzkabel. Verwenden Sie nur das mit diesem Produkt ausgelieferte und
für das Einsatzland zugelassene Netzkabel.

Schließen Sie das Gerät ordnungsgemäß an. Trennen oder schließen Sie keine Tastköpfe oder Prüfleitungen
an, während diese an einer Spannungsquelle anliegen.

Schließen Sie das Gerät ordnungsgemäß an. Unterbinden Sie die Stromzufuhr für den Messpunkt, bevor Sie den
Tastkopf anschließen oder vom Gerät trennen.

Erden Sie das Produkt. Das Gerät ist über den Netzkabelschutzleiter geerdet. Zur Verhinderung von Stromschlägen
muss der Schutzleiter mit der Stromnetzerdung verbunden sein. Vergewissern Sie sich, dass eine geeignete Erdung besteht,
bevor Sie Verbindungen zu den Eingangs- oder Ausgangsanschlüssen des Geräts herstellen.

Beachten Sie alle Angaben zu den Anschlüssen. Beachten Sie zur Verhütung von Bränden oder Stromschlägen
die Kenndatenangaben und Kennzeichnungen am Gerät. Lesen Sie die entsprechenden Angaben im Gerätehandbuch,
bevor Sie das Gerät anschließen.

Die Eingänge sind nicht für Anschlüsse an Hauptstromkreise oder Schaltkreise der Kategorien II, III und IV ausgelegt.

Schließen Sie einen Tastkopf nicht an eine Leitung an, deren Spannung die Nennspannung des Tastkopfes überschreitet.

Trennen vom Stromnetz. Der Netzschalter trennt das Gerät von der Stromversorgung. Weitere Anweisungen zur
Positionierung des Schalters finden Sie in der Dokumentation. Blockieren Sie den Netzschalter nicht, da er für die Benutzer
jederzeit zugänglich sein muss.

Schließen Sie die Abdeckungen. Nehmen Sie das Gerät nicht in Betrieb, wenn Abdeckungen oder Gehäuseteile
entfernt sind.

Bei Verdacht auf Funktionsfehler nicht betreiben. Wenn Sie vermuten, dass das Gerät beschädigt ist, lassen
Sie es von qualifiziertem Wartungspersonal überprüfen.

Vermeiden Sie offen liegende Kabel. Berühren Sie keine freiliegenden Anschlüsse oder Bauteile, wenn diese unter
Spannung stehen.

Verwenden Sie die richtige Sicherung. Verwenden Sie nur Sicherungen des für dieses Gerät angegebenen Typs.
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Allgemeine Sicherheitshinweise

Nicht bei hoher Feuchtigkeit oder Nässe betreiben.

Nicht in Arbeitsumgebung mit Explosionsgefahr betreiben.

Sorgen Sie für saubere und trockene Produktoberflächen.
Sorgen Sie für die richtige Kühlung. Weitere Informationen über die Gewährleistung einer ordnungsgemäßen Kühlung
für das Produkt erhalten Sie im Handbuch.

Begriffe in diesem Handbuch
In diesem Handbuch werden die folgenden Begriffe verwendet:

WARNUNG. Warnungen weisen auf Bedingungen oder Verfahrensweisen hin, die eine Verletzungs- oder Lebensgefahr
darstellen.

VORSICHT. Vorsichtshinweise machen auf Bedingungen oder Verfahrensweisen aufmerksam, die zu Schäden am Gerät
oder zu sonstigen Sachschäden führen können.

Symbole und Begriffe am Gerät
Am Gerät sind eventuell die folgenden Begriffe zu sehen:

GEFAHR weist auf eine Verletzungsgefahr hin, die mit der entsprechenden Hinweisstelle unmittelbar in Verbindung steht.

WARNUNG weist auf eine Verletzungsgefahr hin, die nicht unmittelbar mit der entsprechenden Hinweisstelle in
Verbindung steht.

VORSICHT weist auf mögliche Sach- oder Geräteschäden hin.

Am Gerät sind eventuell die folgenden Symbole zu sehen:
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Vorwort
In diesem Handbuch werden die Installation und die Bedienungsgrundlagen der Videomesssysteme der Serie VM
beschrieben. Weitere Informationen finden Sie in der Online-Hilfe für das Instrument und im Benutzerhandbuch für
Videomesssysteme der Serie VM.

Hauptfunktionen
Bei den Videomesssystemen der Serie VM handelt es sich um Hochleistungs-Videomesssysteme auf der Basis einer
Oszilloskopplattform. Sie zeichnen sich durch die folgenden Leistungsmerkmale aus:

Schnelle, genaue und verlässliche Videomessungen

Umfassende Analyse für analoge Komponentensignale

Automatische Prüfung von PC- und DTV-Heimvideogeräten

Automatische VESA-Komformitätsprüfung für PC-Grafikgeräte

Unterstützt analoge SD-, HDTV- und RGBHV-Videoformate über Optionen

Bild-, Vektor- und Signalanzeigen

Integrierte Pass/Fehler-Grenzwertprüfung

Handbuch für Prüfsignalpakete

GPIB-Fernsteuerung und LAN-Anschluss

Umfassende Oszilloskopfunktionalität

Unterstützte Produkte
Videomesssysteme der Serie VM sind als Software- und Hardwarepaket erhältlich. Sie können das Paket auf
Tektronix-Oszilloskopen installieren, die Sie bereits besitzen, oder die Systeme VM5000HD oder VM5000 damit aufrüsten. In
der folgenden Tabelle finden Sie eine Aufstellung der Produkte, die von den Videomesssystemen der Serie VM unterstützt
werden. Beachten Sie, dass einige Produkte die VGA-Option nicht unterstützen.

Instrument Unterstützte Optionen
VM5000HD SD, HD und VGA
VM5000 SD, HD und VGA
TDS5104 SD, HD und VGA
TDS5104B SD, HD und VGA
TDS5054 SD und HD
TDS 5054B SD und HD
DPO7254 SD, HD und VGA
DPO7104 SD, HD und VGA
DPO7054 SD und HD
DPO7354 SD, HD und VGA
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Dokumentation
Informationen Dokumente
Installation und Betrieb (Übersicht) Schnellstart-Benutzerhandbuch für Videomesssysteme der Serie VM.

Das Schnellstart-Benutzerhandbuch enthält allgemeine Informationen
über die Inbetriebnahme des Instruments, einen Leitfaden für
Benutzeroberflächen-Steuerelemente sowie Anwendungsbeispiele.

Ausführliche Hilfe für den Betrieb und die
Benutzeroberfläche

Benutzerhandbuch für Videomesssysteme der Serie VM. Das
Benutzerhandbuch enthält ausführliche Informationen über den Betrieb
des Instruments. Hierzu gehören auch Angaben zur Berechnung von
Messungen sowie technische Daten.
Online-Hilfe für Videomesssysteme der Serie VM. Greifen Sie über das
Hilfemenü der Software auf die Online-Hilfe zu, um Informationen zu den
Bedienelementen und Elementen auf dem Bildschirm zu erhalten.

Programmierbefehle Programmierhandbuch für Videomesssysteme der Serie VM. Die speziell
für die Videomesssysteme der Serie VM geltenden Programmierbefehle
sind in einer PDF-Datei auf der Produktsoftware-CD für das System
aufgeführt. Beim Programmierhandbuch für das Oszilloskop handelt es
sich um eine PDF-Datei auf der Produktsoftware-CD .

Einsatz des Oszilloskops Umfassende Informationen zur Verwendung der Oszilloskopfunktionen
finden Sie in der Dokumentation für das jeweilige Oszilloskop.

Benutzerservice und Leistungsprüfung Informationen finden Sie im Wartungshandbuch für das Oszilloskop.

Softwareaktualisierungen
Gelegentlich können Softwareaktualisierungen verfügbar gemacht werden. Die Software kann nur in Verbindung mit einem
gültigen Optionsschlüssel für das jeweilige Oszilloskopmodell und die betreffende Seriennummer verwendet werden.

So suchen Sie nach Aktualisierungen:

1. Rufen Sie mit www.tektronix.com/software die Tektronix-Website auf.

2. Geben Sie den Produktnamen (Serie VM) ein, um nach verfügbaren Softwareaktualisierungen zu suchen.
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In diesem Handbuch verwendete Konventionen
In diesem Handbuch wird der Umgang mit den Optionen SD, HD und VGA der Videomesssysteme der Serie VM beschrieben.
Obwohl die Betriebsverfahren für alle drei Optionen identisch sind, gibt es einige Unterschiede hinsichtlich der Funktionen,
vor allem bezüglich der verfügbaren Messungen. Die Software und das Zubehör für die Videomesssysteme der Serie VM
sind zudem für die Installation auf ausgewählten Tektronix-Oszilloskopen erhältlich. Unterschiede in der Konfiguration bzw.
in der Anwendung werden im Text durch Angabe der Oszilloskopplattform oder der Option kenntlich gemacht, für die sie
gelten. Bei Unterschieden in der Bildschirmanzeige werden beide Versionen angezeigt (Option SD/HD und Option VGA).

Die folgenden Symbole werden in diesem Handbuch verwendet.

Verfahrenss-
chritt

Netzschalter
auf der
Frontplatte

Netzan-
schluss

Netzwerk PS2 SVGA USB
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Installation des Geräts

Installation des Geräts
In diesem Abschnitt finden Sie Informationen zur Installation Ihres Instruments. Packen Sie das Instrument aus und
überprüfen Sie, ob Sie alle als Standardzubehör angegebenen Teile erhalten haben. Kontrollieren Sie, ob Sie die Teile
des empfohlenen Zubehörs erhalten haben, die Sie zusammen mit Ihrem Instrument bestellt haben. Die aktuellsten
Informationen finden Sie auf der Website von Tektronix (www.tektronix.com).

Standardzubehör

Standardzubehör für Videomesssysteme der Serie VM.

Zubehör
Tektronix
Bestellnummer

Schnellstart-Benutzerhandbuch für das Videomesssystem VM5000 in englischer, französischer,
deutscher, spanischer, chinesischer (traditionell oder vereinfacht) oder japanischer Übersetzung,
wenn eine der Sprachoptionen bestellt wurde.

071-2091-XX

Benutzerhandbuch für Videomesssysteme der Serie VM 071-2103-XX
Programmierhandbuch für Videomesssysteme der Serie VM im PDF-Format auf der
Produktsoftware-CD für das System

071-2104-XX

Schnellstart-Benutzerhandbuch für die Digitalen Phosphor-Oszilloskope DPO7000, DSA70000
und DPO70000

071-1733-XX

Produktsoftware-CD-ROM für das Videomesssystem der Serie VM mit der darin
enthaltenen Produktsoftware und Online-Hilfe, dem PDF-Benutzerhandbuch, dem
Schnellstart-Benutzerhandbuch als PDF und den Versionsinformationen für das
Videomesssystem der Serie VM

020-2767-XX

Produktsoftware-CD zu DPO7000, DSA70000 und DPO70000 020-2693-XX
CD für die Wiederherstellung des Betriebssystems zu DPO7000, DSA70000 und DPO70000 020-2659-XX
Tek-Softwarelizenz „Wiederherherstellung“ für Wiederherstellungsmedien/Betriebssystemwieder-
herstellung

—

CD mit optionaler Anwendungssoftware und Dokumentationssatz 020-2700-XX
Zusammenstellung „Erste Schritte mit OpenChoice-Lösungen“ 020-2513-XX
Online-Hilfe (Bestandteil der Produktsoftware) zu DPO7000, DSA70000 und DPO70000 —
Leistungsprüfung (eine PDF-Datei auf der Produktsoftware-CD)zu DPO7000, DSA70000 und
DPO70000

—

Online-Programmieranleitung (Dateien auf der Produktsoftware-CD) zu DPO7000, DSA70000
und DPO70000

—

NIST, Z540-1 und das ISO9000-Kalibrierungszertifikat —
Optische Maus 119-7054-XX
Minitastatur, USB mit 2-Port-Hub 118-7083-XX
Frontschutzdeckel 200-4963-XX
Zubehörbeutel 016-1966-XX
Tastkopfkalibrierung und Deskew-Überprüfung mit Anweisungen 067-0405-XX
CD mit Nero OEM Software 063-3781-XX
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Standardzubehör für Videomesssysteme der Serie VM. (Fortsetzung)

Zubehör
Tektronix
Bestellnummer

TPA-BNC Austauschadapter für Service
Option SD & HD – 1 Adapter
Option VGA – 4 Adapter

013-0355-02

75 Ω-Präzisionsabschlüsse (4) 011-0102-XX
BNC-T-Verbinder (4) 103-0030-XX
Sync-Pickoff-Kabel (nur für Option SD/HD) 012-1680-XX
VGA-zu-5X BNC-Kabel (12,7 cm lang) (nur für Option VGA) 174-5147-XX
VGA-zu-5X BNC-Kabel (91,4 cm lang) (Nur für Option VGA) 174-5216-XX
RGBHV-Messschnittstelleneinheit (nur für Option VGA) 012-1685-XX
Steuerkabel RS-232 RGBHV MIU (nur für Option VGA) 012-1692-XX
BNC-to-Binding-Post-Adapter (2) (Nur für Option VGA) 011-0183-00
2,21-Kiloohm-Widerstand 322-3226-00
301-Ohm-Widerstand 322-3143-00
VGA Sync Combiner-Kabel 012-1664-XX

Nordamerika (Option A0) 161-0104-00
Europa universal (Option A1) 161-0104-06
Großbritannien (Option A2) 161-0104-07
Australien (Option A3) 161-0104-05
Schweiz (Option A5) 161-0167-00
Japan (Option A6) 161-A005-00
China (Option A10) 161-0306-00
Indien (Option A11) 161-0324-00

Netzkabel

Kein Netzkabel oder Netzteil (Option A99) —
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Empfohlenes Zubehör
Das Instrument kann optional auch empfohlenes Zubehör enthalten. Überprüfen Sie, ob das von Ihnen bestellte optionale
Zubehör dem Instrument beigefügt ist.

Empfohlenes Zubehör für Videomesssysteme der Serie VM 1

Zubehör
Tektronix-
Bestellnummer

Signalquellen für Serie VM, 480 Line DVD und 580 Line DVD 020-2770-XX
Signalquellen für Serie VM, Elementary Streams in Standardauflösung 020-2771-XX
Signalquellen für Serie VM, Elementary Streams für höherwertige Videosignale 020-2772-XX
Signalquellen für Serie VM, ATSC-Transportstreams 020-2773-XX
Signalquellen für Serie VM, Basisband-Prüfsignale 020-2774-XX
Signalquellen für Serie VM, PC-Bitmapdateien für Grafiktests 020-2775-XX
Signalquellen für Serie VM, SD & HD-Streams nach H.264 020-2776-XX
Wartungshandbuch für Digital-Phosphor-Oszilloskope der Serie DPO70000 071-1174-XX
Transportkoffer 016-1942-00
Tastkopfkalibrierungs-, Kompensations- und Deskew-Adapter 067-0405-XX
Vorrichtung für den Strom-Deskew 067-1478-00
Video-Anzeigeklemme 013-0278-XX
Passiver Tastkopf P5050 500 MHz 10x P5050
GPIB-Kabel (1 m) 012-0991-01
GPIB-Kabel (2 m) 012-0991-00
Centronics-Kabel (Drucker) 012-1214-00
1 Auf unserer Website unter www.tektronix.com finden Sie eine aktuelle Liste mit Zubehör, Aktualisierungen und Optionen, einschließlich der für

Ihr Videomesssystem der Serie VM verfügbaren Serviceoptionen.
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Betriebsvoraussetzungen
1. Stellen Sie das Gerät auf einem

Rollwagen oder einen Labortisch,
und beachten Sie die erforderlichen
Abstände:

Oberseite, Rückseite, Vorderseite
und rechte Seite 0 mm

Linke Seite: 76 mm

Unten: 19 mm oder 0 mm
mindestens bei Fußaufstellung,
Stand heruntergeklappt

2. Stellen Sie vor dem Betrieb sicher, dass
die Umgebungstemperatur zwischen
+5°C und +45°C liegt.

VORSICHT. Halten Sie die Unterseite und die Seiten des Geräts frei, um die erforderliche Kühlung zu gewährleisten.

Einschalten des Geräts
Stromversorgung - Voraussetzungen
Stromspannung und -frequenz Stromverbrauch
100-240 Veff ±10%, 47-63 Hz oder 115 Veff ±10%,
360-440 Hz

550 W, max.

4 Schnellstart-Benutzerhandbuch für Videomesssysteme der Serie VM



Installation des Geräts

Ausschalten des Geräts

Abziehen des Netzkabels

Verbindung zu einem Netzwerk herstellen
Das Anschließen des Geräts an ein
Netzwerk ermöglicht u. a. das Drucken, das
gemeinsame Nutzen von Dateien und den
Zugriff auf das Internet. Wenden Sie sich an
Ihren Netzwerkadministrator, und verwenden
Sie die Windows-Standardprogramme, um
das Gerät für Ihr Netzwerk zu konfigurieren.
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Umgang mit dem Gerät

Vorderseite
1. DVD/CD-RW-Laufwerk

2. Steuerelemente auf der Frontplatte

3. USB-Schnittstelle

4. Erdungsklemme

5. Zusätzlicher Triggereingang

6. Eingang für die Kanäle 1-4

7. Tastkopfkalibrierungsausgang

8. Tastkopfkompensationsausgang
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Seitenplatten und Rückplatte
1. USB-Schnittstellen

2. Videoanschluss zum Anschließen eines
Monitors für die Anzeige nebeneinander

3. Mic-Stecker für das Mikrofon

4. Line-Out-Stecker für den Lautsprecher

5. Scope Only XGA Out-Videoanschluss
zum Anschließen eines Monitors

6. Druckerverbindung

7. Line-In-Stecker

8. RJ-45-LAN-Stecker für den Anschluss
an ein Netzwerk

9. Parallele Schnittstelle (Centronics)

10. Serielle Schnittstelle COM 1

11. PS-2-Anschluss für die Maus

12. PS-2-Anschluss für die Tastatur

13. TekLink-Stecker für zukünftige
Anwendungen

14. Wechselfestplatten-Laufwerk

15. GPIB-Schnittstelle für den Anschluss an
den Controller

16. Zusätzlicher Ausgang

17. Ausgang für Kanal 3

18. Externer Referenzeingang
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Voraussetzungen für Eingangsverbindungen – Optionen SD/HD
Verwenden Sie nur 75 Ω-Koaxialkabel, um das geprüfte Videobauteil an das Instrument anzuschließen.

Installieren Sie die beiliegenden
75-Ohm-Abschlüsse mit Hilfe
der BNC-T-Verbinder zwischen
den Koaxialkabeln und den
Geräteingangskanälen. Um genaue
Frequenzgangmessungen zu erreichen, ist
es unerlässlich, die T-Verbinder direkt an die
Eingangskanal-BNCs anzuschließen.

Voraussetzungen für Eingangsverbindungen – Option VGA
Die bevorzugte Methode zum Anschließen
des geprüften Videobauteils an das
Instrument besteht in der Verwendung
der RGBHV-Messschnittstelleneinheit.
Die Messschnittstelleneinheit enthält
eine impedanzangepasste Schaltung und
gewährleistet so genaue Messergebnisse.
Für einige Messungen wird ein
Niederfrequenzpfad verwendet, für andere
Messungen hingegen ein Breitbandpfad.
Die Serie VM wählt den zu verwendenden
Pfad über eine RS-232-Verbindung mit der
Messschnittstelleneinheit aus.

Sie können das geprüfte Videobauteil
auch mit Hilfe des mitgelieferten
VGA-Anschluss-zu-5X-Kabels an das
System der Serie VM anschließen. Wenn
Sie sich für dieses Verfahren entscheiden,
wird das Kabel mit Hilfe der gelieferten
Präzisionsabschlüsse an das System der
Serie VM angeschlossen. Je nachdem,
welche Messungen ausgeführt werden
sollen, müssen Sie die Abschlüsse während
der Messungen möglicherweise manuell
wechseln.
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Verbinden von Eingangssignalen
Setup 1 für Option SD/HD
Die Setups 1A und 1B werden zum Überprüfen analoger Videokomponentensignale (Y/G, Pb/B, Pr/R) für dreiadrige Kabel
mit dem Composite-Sync-Signal auf Y/G bevorzugt. Sie leiten das Triggersignal mit Hilfe des Sync-Pickoff-Zubehörs
aus dem Y/G-Signal auf CH1 ab. Die Triggerquelle ist auf Kanal 4 festgelegt. Diese Konfiguration ermöglicht genauere
rauscharme Messungen (unter -60 dB bei einer Bandbreite von 30 MHz) als Setup 2.

Durch diese Verbindungsart wird während der Triggerung auf CH4 eine genauere Rauschmessung auf CH1 ermöglicht,
ohne dass eine zusätzliche Verkabelung zwischen CH1 und CH4 erforderlich wäre. Die zusätzliche Verkabelung kann den
Frequenzgang beeinträchtigen und zu Mehrfachbursts bei Messungen führen.

Um den besten Frequenzgang und Mehrfachburst-Messungen zu erreichen, muss der 75 Ω-Abschluss so nah wie möglich
an den Eingangsanschluss angeschlossen sein, wie in der Setup-Abbildung dargestellt.

Es gibt zwei Möglichkeiten, um das Sync-Pickoff an das System der Serie VM anzuschließen. Bei der ersten Möglichkeit
wird das Sync-Pickoff direkt an den Eingang angeschlossen, bei der zweiten Möglichkeit erfolgt dies mit Hilfe eines
T-Verbinders, der an einen 75 Ω-Abschluss angeschlossen wird. Die verwendete Methode richtet sich nach der von Ihnen
eingesetzten Sync-Pickoff-Version.

Setup 1A - Dreiadriges Analogvideokabel und mit Composite-Sync for Sync-Pickoff 012-1680-01. Bei
Verwendung eines 012-1680-01-Sync-Pickoffs (mit einem internen 75 Ω-Abschluss) schließen Sie das Sync-Pickoff
entsprechend der folgenden Abbildung direkt an den CH1-Eingang des Systems der Serie VM an (mit einem
TPA-BNC-Adapter für VM6000 und Instrumente der Serie DPO7000). Bei Verwendung eines 012-1680-00-Sync-Pickoffs
(erfordert einen externen 75 Ω-Abschluss) gehen Sie wie in der Abbildung in Setup 1B vor.

Anschließen an ein Instrument der Serie VM6000 / DPO7000.
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Anschließen an ein Instrument der Serie VM5000 / TDS5000.

Setup 1B – Dreiadriges Analogvideokabel mit Composite-Sync für Sync-Pickoff 012-1680-00. Bei
Verwendung eines 012-1680-00-Sync-Pickoffs (die Teilenummer befindet sich auf dem Etikett des größeren Moduls)
schließen Sie das Sync-Pickoff entsprechend der folgenden Abbildung an den CH1-Eingang des Systems der Serie VM an.
Bei Verwendung eines 012-1680-01-Sync-Pickoffs gehen Sie entsprechend der Abbildung in Setup 1A vor.

Anschließen an ein Instrument der Serie VM6000 / DPO7000.
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Anschließen an ein Instrument der Serie VM5000 / TDS5000.

Die folgende Abbildung veranschaulicht, wie das 012-1680-00-Sync-Pickoff an den CH1-Eingang angeschlossen wird.

HINWEIS. Stellen Sie sicher, dass der Triggerkanal auf Kanal 4 festgelegt ist (Standardeinstellung). Wenn die
Triggereinstellung („Configuration > Operation“) (Konfiguration > Betrieb) nicht auf CH4 festgelegt ist, werden
Signalwarnmeldungen angezeigt, und es können keine Messungen ausgeführt werden.
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Setup 2 für Option SD/HD – Dreiadriges Analogvideokabel mit Composite-Sync
Dieses Setup kann verwendet werden, um Analogvideosignale (Y/G, Pb/B, Pr/R) für dreiadrige Kabel mit dem
Composite-Sync-Signal auf Y/G zu prüfen. Legen Sie die Triggerung für das Instrument auf CH1 fest (die
Triggerstandardeinstellung ist CH4). Dieses Setup ist einfacher als die anderen in diesem Kapitel erwähnten, es beschränkt
jedoch die Rauschmessung auf Y/G bis -65 dB (30 MHz Rauschbandbreite).

Anschließen an ein Instrument der Serie VM6000 / DPO7000.

Anschließen an ein Instrument der Serie VM5000 / TDS5000.
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Setup 3 für Option SD/HD – Dreiadriges Analogvideokabel mit Separater Composite-Sync
Verwenden Sie dieses Setup zum Prüfen analoger Videokomponentensignale (Y/G, Pb/B, Pr/R) für vieradrige Kabel
mit dem Composite-Sync-Signal an einem separaten Ausgang. Für CH4 können Sie das Signal ohne einen Abschluss
anschließen, oder Sie können einen 75-Ohm-Abschluss verwenden, der weniger präzise ist als die mit dem Gerät gelieferten
75-Ohm-Abschlüsse.

Anschließen an ein Instrument der Serie VM6000 / DPO7000.

Anschließen an ein Instrument der Serie VM5000 / TDS5000.

HINWEIS. Stellen Sie sicher, dass der Triggerkanal auf Kanal 4 festgelegt ist (Standardtriggerkanal). Wenn die
Triggereinstellung nicht auf CH4 („Configuration > Operation“) (Konfiguration > Operation) festgelegt ist, werden
Signalwarnmeldungen angezeigt, und es können keine Messungen ausgeführt werden.
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Setup 1 für Option VGA – RGBHV-Messschnittstelleneinheit
Dies ist das bevorzugte Setup zum Prüfen von PCs und Videogeräten. Verwenden Sie die RGBHV-Messschnittstelleneinheit,
um die PC-Videokarte an das System der Serie VM anzuschließen. Bei Verwendung der RGBHV-Messschnittstelleneinheit
werden die genauesten Messergebnisse erzielt.

Anschließen an ein Instrument der Serie VM6000 / DPO7000.
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Anschließen an ein Instrument der Serie VM5000 / TDS5000.

So schließen Sie die RGBHV-Messschnittstelleneinheit an:

1. Schließen Sie das geprüfte Bauteil
mit Hilfe eines der mit dem
System der Serie VM gelieferten
VGA-zu-BNC-Adapterkabel
an den Eingang der
RGBHV-Messschnittstelleneinheit
an.
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2. Schließen Sie die Ausgänge
(AUX, CH1–CH4) der
RGBHV-Messschnittstelleneinheit
an die entsprechenden Ausgänge
des Systems der Serie VM (d. h.
CH1-Ausgang an CH1-Eingang) an.

Instrument der Serie VM6000 / DPO7000

Serie VM5000 / TDS5000
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3. Verbinden Sie die RGBHV-
Messschnittstelleneinheit und den
COM1-Anschluss am System der Serie
VM mit dem RS-232-Kabel.

4. Überprüfen Sie, ob auf der
Registerkarte „Configuration >
Operation“ (Konfiguration > Betrieb)
das Kontrollkästchen Use MIU
(Messschnittstelleneinheit verwenden)
aktiviert ist.

Setup 2 für Option VGA – VGA-Anschluss an 5X-Kabel
Verwenden Sie dieses Setup zum Prüfen von PCs und Videogeräten, wenn sich die RGBHV-Messschnittstelleneinheit nicht
dazu eignet. Um sicherzustellen, dass die Messungen genau sind, schließen Sie das System der Serie VM an die T-Verbinder
und Präzisionsanschlüsse an CH1-CH4 an. Sie müssen den 75 Ω-Abschluss an CH1-CH3 (verwendet für GBR) und den
2,21 kΩ- sowie den 301 Ω-Abschluss an CH4 verwenden (verwendet für H Sync- und V Sync-Messungen). Diese Methode
erfordert, dass die Signal- und Abschlussanschlüsse an CH4 für bestimmte horizontale und vertikale Messungen geändert
werden. Das System der Serie VM zeigt ein Dialogfeld an, in dem Sie dazu aufgefordert werden, ggf. diese Änderungen
vorzunehmen (die RGBHV-Messschnittstelleneinheit führt diese Anschluss- und Abschlussänderungen intern durch).

So schließen Sie das geprüfte Bauteil mit Hilfe eines VGA-zu-5x-Kabels an das System der Serie VM an:

1. Installieren Sie die beiliegenden
75-Ohm-Abschlüsse mit Hilfe
der BNC-T-Verbinder zwischen
den BNC-Kabeln und den
Geräteingangskanälen 1 bis 3.
Um präzise Messungen zu erreichen,
ist es unerlässlich, die T-Verbinder
direkt an die Eingangskanal-BNCs
anzuschließen.
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2. Bei der Ausführung von H Sync-,
V Sync- oder V Timing-Messungen sind
2,21-Kiloohm- und 301-Ohm-Abschlüsse
erforderlich. Dazu werden die
als Standardzubehör gelieferten
BNC-to-Binding-Post-Adapter und
-Widerstände benötigt. Schließen Sie
jeden Widerstand an einen Adapter an,
wie in der Abbildung dargestellt.

3. Legen Sie die VGA-Signale
entsprechend der Abbildung an
das System der Serie VM an. Schließen
Sie zunächst das H Sync-Signal mit
Hilfe des 2,21 kΩ-Abschlusses an.
Das System der Serie VM fordert Sie
ggf. auf, den 301 Ω-Abschluss zu
verwenden.

Instrument der Serie VM6000 / DPO7000
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Instrument der Serie VM5000 / TDS5000

In einer Popupwarnung werden Sie
beim Ausführen einer H Sync-Messung
aufgefordert, den Signalabschluss auf CH4
zu ändern.

In der folgenden Tabelle ist dargestellt, welches Signal vom geprüften Bauteil an welchen Eingang des Systems der Serie
VM angeschlossen und welcher Abschluss für die einzelnen Signale verwendet wird.

VGA-Signal Eingang des Systems der Serie VM Abschluss
Grün CH 1 75 Ohm
Blau CH 2 75 Ohm
Rot CH 3 75 Ohm
H Sync CH 4 1 2,21 Kiloohm und 301 Ohm
V Sync AUX Kein
1 Das V Sync-Signal ist bei der Durchführung von V Timing- und V Sync-Messungen an diesen Kanal angeschlossen. Das System der Serie VM

fordert Sie ggf. auf, diesen Anschluss zu verwenden.
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Signalpfadkompensation
Zum Optimieren der Messgenauigkeit lesen Sie bitte in der Online-Hilfe zum Oszilloskop nach, und führen Sie die folgenden
Verfahren für die Signalpfadkompensation des Instruments aus: Verwenden Sie dieses Verfahren, wenn sich die Temperatur
seit der letzten Signalpfadkompensation um mehr als 5° C geändert hat. Führen Sie die Signalpfadkompensation
einmal wöchentlich durch. Wenn Sie dies unterlassen, kann das Instrument bei diesen Einstellungen für Volt/Skalenteil
möglicherweise nicht die garantierte Leistung erreichen.

Sync-Pickoff-Kompensation – Serien VM6000 und DPO7000, nur Optionen
SD/HD

So kompensieren Sie das Sync-Pickoff ordnungsgemäß:

1. Verbinden Sie das kleine Gehäuse
des Sync-Pickoff (gekennzeichnet
mit “Connect to Trigger Channel” /
Anschließen an Triggerkanal) mit CH4.
Lassen Sie das große Gehäuse vom
Instrument getrennt.

2. Schließen Sie den Sync-Pickoff-
BNC-Anschluss an einen BNC-zu-
Minigrabber-Anschluss an (Pomona
Electronics-Modellnummer 3789)

3. Schließen Sie die Minigrabber an den
PROBE COMP-Anschluss an.
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4. Drücken Sie AUTOSET (AUTO-SETUP).

5. Überprüfen Sie die Form des
angezeigten Signals, um zu bestimmen,
ob der Sync-Pickoff ordnungsgemäß
kompensiert ist.

6. Stellen Sie den Sync-Pickoff ggf. ein.
Wiederholen Sie diesen Vorgang so oft
wie nötig.

Sync-Pickoff-Kompensation – Serien VM5000 und TDS5000, nur Optionen
SD/HD

So kompensieren Sie das Sync-Pickoff ordnungsgemäß:

1. Schließen Sie das Sync-Pickoff-Kabel
an CH1 und CH4 an. Verbinden Sie
das kleine Gehäuse des Sync-Pickoff
(gekennzeichnet mit “Connect to Trigger
Channel” / Anschließen an Triggerkanal)
mit CH4.
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2. Schließen Sie den Sync-Pickoff-
BNC-Anschluss an einen BNC-zu-
Minigrabber-Anschluss an (Pomona
Electronics-Modellnummer 3789)

3. Schließen Sie die Minigrabber an den
PROBE COMP-Anschluss an.

4. Wählen Sie CH1 und CH4. Drücken Sie
FastAcq (Schnellerfassung). Drücken
Sie AUTOSET (AUTO-SETUP).
Die Signale beider Kanäle (CH1
und CH4) werden angezeigt. Es
ist normal, dass das Signal eine
Schräge aufweist. Dies ist auf die
75 Ω-Terminierungslast des Sync-Pickoff
am PROBE COMP-Ausgangssignal
zurückzuführen.

5. Überprüfen Sie die Form des
angezeigten Signals, um zu bestimmen,
ob der Sync-Pickoff ordnungsgemäß
kompensiert ist.

Ordnungsgemäß kompensiert

Unterkompensiert
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Überkompensiert

6. Stellen Sie den Sync-Pickoff ggf. ein.
Wiederholen Sie diesen Vorgang so oft
wie nötig.
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Informationen zum Matrixtestsignal
Das Matrixtestsignal befindet sich auf den diesem Produkt beigefügten Disketten mit Signalquellen. Es gibt ein
Matrixsignal für die Optionen SD und HD und ein Matrixsignal für die Option VGA. Das Matrixsignal enthält alle
Analogvideosignalanforderungen in verschiedenen Zeilennummern innerhalb eines Prüfmusterfeldes. Durch die Verwendung
eines einzigen Prüfmusters müssen die Prüfsignale während der verschiedenen Messungen nicht geändert werden. Sie
müssen nur die Anzahl der Zeilennummern angeben, für die die Messungen ausgeführt werden sollen. Verwenden Sie die
Setup-Datei (.vmset), die dem Format des von Ihnen verwendeten Matrixprüfsignals entspricht. Dadurch werden für jeden
Messtyp die als Standardeinstellung geeigneten Zeilennummern zur Verfügung gestellt. Eine vollständige Beschreibung der
Dateien auf den Signalquellendisketten finden Sie im Benutzerhandbuch für die Videomesssysteme der Serie VM.

Matrixsignal für Option SD/HD

Matrixsignal für Elemente der Option SD/HD
Signalname Format Signalname Format Signalname Format
1. Farbbalken Alle 7. YPbPr-Ablenkzeit YPbPr 13. Gültige Rampe Alle
2. RGB-Impulsbalken RGB 8. YPbPr-

Ablenkfrequenz
YPbPr 14. YPbPr-

Flachrampe
YPbPr

3. RGB-
Frequenzablenkung

RGB 9. YPbPr-
Mehrfachburst

YPbPr 15. RGB-
Flachrampe

RGB

4. RGB-Zeitablenkung RGB 10. YPbPr-
Mehrfachburst

YPbPr 16. Flaches
Halbbild 7,5 %

Alle

5. RGB-
Mehrfachburst

YPbPr 11. RGB-
Übersprechen

RGB 17. Flaches
Halbbild 50 %

Alle

6. YPbPr-
Impulsbalken

YPbPr 12. YPbPr-
Übersprechen

YPbPr 18. Flaches
Halbbild 100 %

Alle
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Matrixsignal für Option VGA

Matrixsignal der Elemente für Option VGA
Signalname Signalname
1. Hälfte weiß und Hälfte schwarz 5. Schwarz/weiß/schwarz
2. Neun Farbbalken 6. Vollweiß
3. 32 Stufen 7. Rampe
4. Alternierend weiß und schwarz 8. Hälfte weiß und Hälfte schwarz
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Starten der Systemsoftware der Serie VM
1. Schalten Sie das Gerät ein.

2. Wählen Sie Analyze > VM HD and
SD Video V3.2 (Datei > VM HD- und
SD-Video V3.2) oder VM VGA Video
V3.2 (VM VGA-Video V3.2).

Option SD/HD

Option VGA
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Das Instrument zeigt das Signal nur in
der oberen Hälfte der Anzeige an und
öffnet die Anwendung des Systems
der Serie VM in der unteren Hälfte der
Anzeige.

Option SD/HD

Option VGA
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Die Benutzeroberfläche der Serie VM-Software
1. Menüleiste: Wählt die in der

Anwendungsanzeige anzuzeigenden
Bedienelemente für Einstellungen und
Informationen zu den Ergebnissen an.

2. Anwendungsanzeige: Zeigt die
Bedienelemente für die Konfiguration
und die Messergebnisse an.

3. Schaltfläche „Run“ (Ausführen): Initiiert
das Einrichten, startet die Messungen
und zeigt die Ergebnisse an. Die
Darstellung der Schaltfläche hängt vom
Betriebsmodus und den „Line Select“
(Zeilenauswahl)-Einstellungen ab.

Schaltfläche „Run“, wenn der
Betriebsmodus auf „Once“ (Einmal)
oder „Once and Report“ (Einmal und
Bereicht) festgelegt ist und „Line Select“
(Zeilenauswahl) auf „Single Line“
(Einzelne Zeile) festgelegt ist.

Schaltfläche „Run“, wenn „Line Select“
(Zeilenauswahl) auf „Multi Lines“
(Mehrere Zeilen) festgelegt ist.

Schaltfläche „Run“, wenn der
Betriebsmodus auf „Continuous“
(Kontinuierlich) festgelegt ist.

4. Schaltfläche „Stop“ (Anhalten): Hält
Messungen an.

5. Schaltfläche „Picture“ (Bild): Zeigt das
Signal als Bild an.

6. Schaltfläche „Vectorscope“ (Vektorskop):
Zeigt das Signal im Vektorskop-Format
an. (Nur Option SD/HD)
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7. Schaltfläche „Hide“ (Ausblenden):
Stellt die Hauptanzeige als
Gesamtbildschirm wieder her und
verbirgt das Anwendungsfenster hinter
der Hauptanzeige.
Wählen Sie Hide (Ausblenden) aus, um
(zum Anzeigen von Berichten) auf den
Windows-Desktop zuzugreifen. Wählen
Sie in der Hauptanzeige File > Minimize
(Datei > Minimieren >) aus, und klicken
Sie dann erneut auf die Schaltfläche
Hide (Ausblenden).

8. So stellen Sie eine ausgeblendete
Anwendung wieder her: Wählen Sie
den Befehl Restore Application
(Anwendung wiederherstellen) im
Menü Analyze (Analysieren) (VM60000
/ DPO7000), oder klicken Sie auf
Schaltfläche App (Anw.) (VM5000 /
TDS5000).

VM6000 / DPO7000

VM5000 / TDS5000

9. Schaltfläche Exit (Beenden): Beendet
die Anwendung der Serie VM und
setzt das Instrument zurück auf die
standardmäßige Hauptanzeige.
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Verfahren zum Ausführen von Messungen
1. Legen Sie die Formatparameter für das Eingangssignal mit Hilfe von Configuration > Format (Konfiguration >

Format) fest.

2. Wählen Sie eine oder mehrere durchzuführende Messungen mit Hilfe vonConfiguration > Measurements
(Konfiguration > Messungen) aus.

3. Legen Sie die Ausführungsoptionen für Messungen mit Hilfe von Configuration > Operation (Konfiguration > Betrieb)
fest.

4. Klicken Sie auf die Schaltfläche „Run“ (Ausführen), um die Messungen auszuführen und anzuzeigen.

5. Speichern Sie die Messergebnisse mit Hilfe von Utilities > Generate Report (Dienstprogramme > Bericht generieren)

Konfigurieren des Prüflings – Option VGA
Um die Messungen für das geprüfte Bauteil durchzuführen, müssen Sie ein entsprechendes Videosignal an das System der
Serie VM anlegen. Dies erreichen Sie durch das Anzeigen einer Bitmapdatei auf dem PC, über den das geprüfte Bauteil
betrieben wird. Beim Durchführen mehrerer Messungen stellt das Matrixsignal die bevorzugte Bitmapdatei dar. Wenn Sie
nur eine Messung ausführen, kann ein Prüfmuster mit vollständigem Halbbild anstelle des Matrixsignals verwendet werden.
Alle erforderlichen Bitmaps für Matrixsignal und Prüfmuster mit vollständigem Halbbild zum Überprüfen der Einhaltung des
VESA-Überprüfungsverfahrens – Auswertung der Anzeigegrafik-Untersysteme (Version 1, Rev. 1) finden Sie auf der
CD-ROM PC-Bitmapgrafik-Prüfsignaldateien.

1. Legen Sie die Auflösung und die
Aktualisierungsrate des Prüflings auf die
erforderlichen Werte fest.

2. Zeigen Sie auf dem PC mit dem
Prüfling den Inhalt der CD-ROM
PC-Bitmapgrafik-Prüfsignaldateien an.

3. Zeigen Sie entweder den Inhalt des
Ordners „Matrix“ oder des Ordners „Full
Field“ (Vollständiges Halbbild) an.

Öffnen Sie den Ordner „Matrix“, wenn
mehrere Messungen ausgeführt
werden sollen.

Wenn nur eine Messung ausgeführt
werden soll, öffnen Sie den
Ordner „Full Field“ (Vollständiges
Halbbild), und wählen Sie mit
Hilfe der folgenden Tabelle das
entsprechende Prüfmuster aus.
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Entsprechende Messungen für die jeweiligen Prüfmuster mit vollständigem Halbbild
Messung Jeweilige(s) Prüfmuster
Konflikt zwischen Kanälen 32-Stufen-Treppe
Versatz zwischen Kanälen Alternierend Weiß und Schwarz
Farbbalken Neun Farbbalken
H Sync Beliebiges Muster
H Sync-Jitter Beliebiges Muster
H Timing Schwarz/weiß/schwarz
Linearität Treppe
Luminanzstufen Alternierend Weiß und Schwarz
Rauschinjektions- verhältnis Vollweiß
Video-Transiente Alternierend Weiß und Schwarz
V Sync Beliebiges Muster
V Timing Hälfte weiß und Hälfte schwarz

Unabhängig davon, ob Sie ein einzelnes Prüfmuster auswählen oder mehrere Messungen auführen, müssen Sie die
Bitmapdatei auswählen, die zum Generieren des Videoprüfsignals angezeigt werden soll. Die ausgewählte Datei ist
abhängig vom zu prüfenden Format. Angenommen, Sie möchten ein Format mit einer Auflösung von 1280 x 1024 prüfen (die
Aktualisierungsrate wird bei der Auswahl von Bitmapdateien nicht berücksichtigt). Suchen Sie im entsprechenden Ordner
nach einen Dateinamen, der dem Format der durchzuführenden Prüfung entspricht. Wenn die Linearität geprüft werden soll,
müssen Sie entweder ein Treppenprüfmuster mit vollständigem Halbbild auswählen oder das Matrixprüfmuster verwenden.
Im Ordner „Staircase“ (Treppe) müssen Sie nach einer Datei mit dem Namen STEP1280X1024.bmp suchen. Suchen Sie im
Ordner „Matrix“ (Matrix) nach einer Datei mit dem Namen MAT1280X1024.bmp.

4. Wählen Sie die Bitmapdatei aus, die den
Anforderungen entspricht, und öffnen
Sie die Datei mit einem Programm wie
Paint Shop Pro.
Wenn Sie den Prüfling für eine zweite
Anzeige einrichten, können Sie den
Hintergrund der zweiten Anzeige auf die
Bitmapdatei festlegen, anstatt die Datei
in einem Bitmap-Editor zu öffnen.
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5. Wählen Sie im Menü „View“ (Ansicht)
die Option View > Full Screen Preview
(Ansicht > Vollbildvorschau) aus.
Die BMP-Datei wird im Vollbildmodus
ohne Ränder angezeigt.

6. Trennen Sie den Ausgang des geprüften
Bauteils vom Monitor, und schließen
Sie den Ausgang des Prüflings an das
System der Serie VM an.

Festlegen des Eingangssignalformats – Optionen SD/HD
1. Wählen Sie Configuration > Format

(Konfiguration > Format) aus.

Die Anwendung zeigt die Ansicht
„Format“ an.
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2. Wählen Sie das entsprechende
Videoformat für das gemessene Signal
aus.

3. Wählen Sie den entsprechenden
Farbraum für das gemessene Signal
aus.

Erstellen eines benutzerdefinierten Formats
Wenn Sie ein Format prüfen möchten, das auf der Registerkarte Format nicht aufgelistet ist, können Sie ein
benutzerdefiniertes Format erstellen.

1. Wählen Sie Configuration > Format
(Konfiguration > Format) aus.

Die Anwendung zeigt die Ansicht Format
an.

2. Wählen Sie Add (Hinzufügen) aus, um
ein neues Format hinzuzufügen. Hiermit
wird das Fenster Create User Defined
Format (Benutzerdefiniertes Format
erstellen) angezeigt.
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3. Geben Sie Werte sowohl für die
horizontalen als auch vertikalen
Parameter an, die das Format angeben.

Legen Sie den Abtasttyp fest.

Legen Sie den Sync-Typ fest.

Geben Sie einen Wert für die
Framerate ein.

4. Geben Sie einen Formatnamen ein, und
wählen Sie Save (Speichern) aus, um
das neue Format zu speichern.

5. Wenn Sie ein benutzerdefiniertes Format
verwenden möchten, aktivieren Sie das
Kontrollkästchen User Defined Format
(Benutzerdefiniertes Format) auf der
Registerkarte Format. Wählen Sie das
gewünschte Format aus der Liste aus.

Festlegen des Eingangssignalformats – Option VGA
1. Wählen Sie Configuration > Format

(Konfiguration > Format) aus.

Die Anwendung zeigt die Ansicht
„Format“ (Format) an.
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2. Wählen Sie die entsprechende Auflösung
für das gemessene Signal aus.

3. Wählen Sie die Aktualisierungsrate für
das gemessene Signal aus. Je nach
der ausgewählten Auflösung sind einige
Aktualisierungsraten nicht auswählbar.

4. Wählen Sie den „Timing“-Standard für
das Signal aus.

Erstellen eines benutzerdefinierten Formats
Wenn Sie ein Format prüfen möchten, das auf der Registerkarte „Format“ nicht aufgelistet ist, können Sie ein
benutzerdefiniertes Format erstellen.

1. Wählen Sie Configuration > Format
(Konfiguration > Format) aus.

Die Anwendung zeigt die Ansicht
„Format“ (Format) an.

2. Aktivieren Sie das Kontrollkästchen
User-Defined Format
(Benutzerdefiniertes Format), um
ein benutzerdefiniertes Format
hinzuzufügen.
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3. Wählen Sie Add (Hinzufügen) aus,
um die Parameter des neuen Formats
festzulegen.

4. Geben Sie Werte sowohl für die
horizontalen als auch vertikalen
Parameter an, die das Format angeben.

Legen Sie die Sync-Polarität fest.

Geben Sie einen Wert für die
Aktualisierungsrate ein.

5. Geben Sie einen Formatnamen ein, und
wählen Sie Save (Speichern) aus, um
das neue Format zu speichern.

6. Wenn Sie ein benutzerdefiniertes Format
verwenden möchten, aktivieren Sie das
Kontrollkästchen User Defined Format
(Benutzerdefiniertes Format) auf der
Registerkarte Format. Wählen Sie das
gewünschte Format aus der Liste aus.
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Auswählen von Messungen
1. Wählen Sie Configuration> >

Measurements> (Konfiguration >
Messungen) aus.

2. Wählen Sie auf der Registerkarte
„Measurements“ (Messungen) die
gewünschten Messungen aus. Sie
können eine Messung oder eine
beliebige Kombination von Messungen
auswählen.

Option SD/HD

Option VGA
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Festlegen der Ausführungsoptionen für Messungen
1. Wählen Sie Configuration > Operation

(Konfiguration > Betrieb) aus.

Option SD/HD

Option VGA

Das Gerät zeigt die Ansicht „Operation“
(Betrieb) an. Mit Hilfe dieser
Einstellungen wird festgelegt, wie
das Gerät nach Klicken auf „Run“
(Ausführen) das Setup durchführt und
die Messwerte erfasst.

Option SD/HD

Option VGA

2. Legen Sie das Setup des Geräts fest,
und bestimmen Sie die Ausführung von
Messungen.
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Mit Setup & Run (Setup & Ausführen) werden die Geräteeinstellungen konfiguriert, und für jede ausgewählte
Messung und jede Messungserfassung wird eine Messung durchgeführt. Verwenden Sie diese Option, wenn
mehrere Messungen ausgeführt werden, die unterschiedliche Gerätesetups erfordern.

Mit Setup Only (Nur Setup) kann das Gerät für eine Messung konfiguriert werden, es wird jedoch keine Messungen
ausgeführt. Legen Sie mit Hilfe dieser Option benutzerdefinierte Einstellungen fest. Klicken Sie auf die Schaltfläche
„Run“ (Ausführen), um die vorgenommenen Einstellungen zu testen, nehmen Sie die erforderlichen Änderungen vor
(ändern Sie beispielsweise die Horizontalskala), und wählen Sie die Schaltfläche „Run“ (Ausführen) erneut aus.
Wenn Sie mit den festgelegten Einstellungen zufrieden sind, sammeln Sie mit Hilfe der Einstellung „Run Only“
(Nur ausführen) die Ergebnisse.

Mit Run Only (Nur ausführen) kann eine Messung mit der vorhandenen Gerätkonfiguration durchgeführt werden.
Verwenden Sie diese Einstellung, um Messungen mit benutzerdefinierten Einstellungen durchzuführen (siehe obige
Beschreibung zu „Setup Only“ (Nur Setup)).

3. Sie können auswählen, wie die
Anwendung Messungen erfasst („Run
Mode" (Betriebsmodus)).

Mit Once (Einmal) wird jede ausgewählte Messung so oft ausgeführt, wie von der Durchschnittseinstellung
angegeben, und anschließend wird die Ausführung von Messungen beendet. Hierbei handelt es sich um die
Standardeinstellung.

Mit Continuously (Fortlaufend) können fortlaufend Messungen durchgeführt werden. Sie müssen die Schaltfläche
„Stop“ (Anhalten) auswählen, um die Messungen anzuhalten.

Mit Once & Report (Einmal & Bericht) wird jede ausgewählte Messung so oft ausgeführt, wie von der
Durchschnittseinstellung angegeben, und anschließend wird die Ausführung von Messungen beendet und ein
Bericht generiert.

4. Aktivieren oder deaktivieren Sie „Auto
Scale“ (Automatisch skalieren). Mit
„Auto Scale“ (Automatisch skalieren)
können die vertikalen Skaleneinheiten
so angepasst werden, dass die
Eingangssignale das Raster so weit
wie möglich ausfüllen. „Auto Scale“
(Automatisch skalieren) wird einmal für
jede ausgewählte Messung angezeigt.

5. Option SD/HD: Wählen Sie aus,
an welchem Kanal des Geräts das
Sync-Signal für die Triggerung anliegt.
Wenn Sie den falschen Triggerkanal
verwenden, wird eine Signalwarnung
ausgegeben (wenn „Signal Warnings“
(Signalwarnungen) aktiviert ist).
(Siehe Seite 9, Verbinden von
Eingangssignalen.)

Option SD/HD
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6. Wählen Sie die entsprechende
Einstellung für Line Select
(Zeilenauswahl) aus. Im Modus
Single Line (Einzelne Zeile) wird jede
Messung für eine einzelne Zeile (z. B.
Zeile 153) ausgeführt. Im Modus
Multiple Lines (Mehrere Zeilen) werden
Messungen über einen Bereich von
Zeilen (z. B. Zeilen 153 bis 185)
ausgeführt.

Wenn Sie „Multiple Lines“ (Mehrere
Zeilen) auswählen, wird automatisch ein
Bericht in einer Datei gespeichert.

7. Option VGA: Wenn Sie die
RGBHV-Messschnittstelle verwenden,
müssen Sie das Kontrollkästchen Use
MIU (Messschnittstelle verwenden)
aktivieren.

Option VGA

8. Option VGA: Wenn Sie die
Messschnittstelleneinheit verwenden,
können Sie die Einstellung Sync Polarity
(Sync-Polarität) ignorieren.

40 Schnellstart-Benutzerhandbuch für Videomesssysteme der Serie VM



Umgang mit dem Gerät

Da die angegebenen Polaritäten für die H Sync- und V Sync-Signale zwischen den Timing-Standards variieren, werden
Sie vom System der Serie VM aufgefordert, die H Sync- und V Sync-Signale anzuschließen und auf diese Weise
automatisch ihre Polarität zu bestimmen. Wenn die Polarität der Sync-Signale festgelegt ist, beginnt der Messzyklus.
Dieser „Polaritätstest“ wird zu Beginn jedes Messzyklus ausgeführt. Um zu vermeiden, dass ein solcher Test zu Beginn
eines jeden Messzyklus ausgeführt wird, führen Sie nur dann Messungen aus, wenn Auto Detect (Automatisch erfassen)
ausgewählt ist. Wenn ein Messzyklus bei aktivierter Option Auto Detect (Automatisch erfassen) abgeschlossen wurde,
können Sie Auto Detect (Automatisch erfassen) deaktivieren. Sie werden dann nicht aufgefordert, die Signale für die
Polaritätsprüfung erneut zu ändern (die Polarität der Sync-Signale wird vom System der Serie VM gespeichert). Wenn
Sie die Formateinstellung für den Prüfling ändern, sollten Sie jedes Mal einen Messzyklus ausführen, wobei Auto Detect
(Automatisch erfassen) aktiviert sein muss.

9. Wählen Sie aus, welche Warnmeldungen
angezeigt werden sollen.
Weitere Informationen über Warnungen
finden Sie im Benutzerhandbuch für das
Videomesssystem der Serie VM.
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Ausführen und Anzeigen von Messungen
Vor dem Ausführen einer Messung müssen Sie ein Signalformat auswählen, die gewünschten Messungen auswählen
und die Ausführungsoptionen konfigurieren.

1. Klicken Sie auf die Schaltfläche
„Run“ (Ausführen). Die Ausführung
der Messungen wird begonnen, und
die Messergebnisse für die zuletzt
ausgewählten Messungen werden
angezeigt.

Option SD/HD

Option VGA

2. Wenn Sie die Ergebnisse einer anderen
Messung anzeigen möchten, wählen
Sie im Menü „Results“ (Ergebnisse)
die betreffende Messung aus. Wählen
Sie beispielsweise Results > Sync
(Ergebnisse > Sync) aus, um die
Sync-Messergebnisse anzuzeigen.

Option SD/HD

Option VGA

3. Wenn die Ausführung auf „Continuously“
(Fortlaufend) festgelegt ist, klicken Sie
auf die Schaltfläche Stop (Anhalten),
um die Ausführung der Messungen zu
beenden.
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Verwenden des Oszilloskops
Wenn Sie Standardfunktionen des Oszilloskops der Serie VM zum Ausführen von Messungen oder zum Anzeigen der
Eigenschaften eines Signals verwenden möchten, blenden Sie einfach die Software der Serie VM aus. Sie müssen die
Software für die Serie VM nicht beenden.

1. Wählen Sie Hide (Ausblenden) aus,
um die Software für die Serie VM
auszublenden.

Wenn die Software für das System
der Serie VM ausgeblendet ist, belegt
die Oszilloskopanzeige den gesamten
Bildschirm. Auf dem Bildschirm wird kein
Hinweis ausgegeben, dass die Software für
das System der Serie VM ausgeblendet ist.
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2. Wählen Sie Restore Application
(Anwendung wiederherstellen) aus, um
die Software für die Serie VM wieder
anzuzeigen.
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Fehlerbehebung bei Signalproblemen
Wenn beim Ausführen der Messungen Probleme auftreten, erhalten Sie möglicherweise Warn- oder Fehlermeldungen,
die Sie beim Ermitteln der Ursache des Problems unterstützen. In den folgenden Tabellen werden die Meldungen und die
möglichen Ursachen für Probleme beschrieben.

Warnmeldungen für die Option SD/HD

Nummer Text Mögliche Ursachen
Eventuell betroffener
Vorgang

1 Acquisition Problem (Problem bei der
Erfassung)

Das Gerät kann kein Signal erzeugen,
oder die Signalpegel liegen außerhalb
des zulässigen Bereichs.

Alle Messungen

2 Bar Measurements Inconclusive
(Balkenmessungen ohne Ergebnis)

Das Gerät kann keine entsprechende
Synchronisation ermitteln, das
falsche Format ist ausgewählt, oder
das Signal ist verzerrt.

Messung kurzzeitiger
Verzerrungen

3 Channel Delay: Channel <x>
& <y>, Correlation Too Low
(Kanalverzögerung: Kanal <x> & <y>,
Korrelation zu gering)

Die Zeilennummer ist falsch
festgelegt, ein verzerrtes Signal oder
ein ungeeignetes Eingangssignal
mit einer zu kleinen Anzahl von
Übergängen.

Messung der
Kanalverzögerung

4 Channel Delay: Disjoint
Correlations Among Channels...
(Kanalverzögerung: disjunkte
Korrelationen zwischen Kanälen...)

Zwischen den Kanälen liegt ein
Gruppenverzögerungskonflikt vor,
oder es wird eine ungeeignete
Signalquelle verwendet.

Messung der
Kanalverzögerung

5 Color Bars: <Color> Bar Not Found
(Farbbalken: Balken <Farbe> nicht
gefunden)

Die Zeilennummer ist falsch
festgelegt, ein verzerrtes Signal,
ein falsches Format ist angegeben,
die angeschlossenen Kanäle liegen
in der falschen Reihenfolge vor,
eine falsche Farbmessung oder
übermäßiger Beschnitt des Signals.

Messung von
Farbbalken

6 Color Bars: Back Porch
Reference Questionable
(Farbbalken: zweifelhafte
Schwarzschalterreferenz)

Das Signal ist verzerrt. Messung von
Farbbalken

7 Frequency Response: Signal
Change: <freq1> –> <freq2> MHz
(Frequenzgang: Signaländerung:
<Freq1> –> <Freq2> MHz)

Signalpegel ist zu niedrig, falsches
Signal oder eine Änderung innerhalb
des Signals.

Messung des
Frequenzgangs

8 Frequency Response Individual
Channel Errors: Channel <x>
(Fehler bei einzelnem Kanal für
Frequenzgang: Kanal <x>)

Das Signal ist verzerrt, oder im Signal
fehlt ein Flag.

Messung des
Frequenzgangs

9 Frequency Response: Invalid results
for all channels (Frequenzgang:
Ungültige Ergebnisse für alle Kanäle)

Die Zeilennummer ist falsch
festgelegt, ein ungeeignetes
Eingangssignal oder eine falsche
Konfiguration.

Messung des
Frequenzgangs
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Warnmeldungen für die Option SD/HD (Fortsetzung)

Nummer Text Mögliche Ursachen
Eventuell betroffener
Vorgang

10 Multiburst: Signal Change: <freq1>
–> <freq2> MHz (Mehrfachburst:
Signaländerung: <Freq1> –> <Freq2>
MHz)

Signalpegel ist zu niedrig, falsches
Signal oder eine Änderung innerhalb
des Signals.

Messung von
Mehrfachburst

11 Multiburst: Individual Channel
Errors: Channel <x>: Flag <= 0 mV
(Mehrfachburst: Fehler bei einzelnem
Kanal: Kanal <x>: Flag <= 0 mV)

Das Signal ist verzerrt, oder im Signal
fehlt ein Flag.

Messung von
Mehrfachburst

12 Multiburst: Individual Channel Errors:
Channel <x>: burst <n>: not detected
(Mehrfachburst: Fehler bei einzelnem
Kanal: Kanal <x>: Burst <n>: nicht
erkannt)

Signalpegel ist zu niedrig, verzerrte
Signale, ein Eingangssignal mit
weniger als sechs Frequenzpaketen
oder übermäßiger Beschnitt des
Signals.

Messung von
Mehrfachburst

13 Multiburst: Invalid results for all
channels (Mehrfachburst: Ungültige
Ergebnisse für alle Kanäle)

Die Zeilennummer ist falsch
festgelegt, ein ungeeignetes
Eingangssignal oder eine falsche
Konfiguration.

Messung von
Mehrfachburst

14 Noise: Signal Change: Chan <x>
(Rauschen: Signaländerung: Kanal
<x>)

Das Signal hat sich während der
Messung geändert.

Messung von Rauschen

15 Noise: Invalid results for all channels
(Rauschen: Ungültige Ergebnisse für
alle Kanäle)

Die Zeilennummer ist falsch
festgelegt, ungeeignetes
Eingangssignal oder falsche
Konfiguration.

Messung von Rauschen

16 Nonlinearity: Invalid Results: Channel
<x>: No ramp or step signal found
(Nichtlinearität: Ungültige Ergebnisse:
Kanal <x>: Kein Rampen- oder
Stufensignal gefunden)

Die Zeilennummer ist falsch
festgelegt, oder es liegt ein
ungeeignetes Eingangssignal an.

Messung von
Nichtlinearität

17 Nonlinearity: Signal Change: Channel
<x>: (Nichtlinearität: Signaländerung:
Kanal <x>:)

Das Signal hat sich während der
Messung geändert.

Messung von
Nichtlinearität

18 Short Time Distortion: Bar Start
Not Found (Kurzzeitige Verzerrung:
Balkenanfang nicht gefunden)

Die Zeilennummer ist falsch
festgelegt, das Signal ist verzerrt,
oder es wurde ein falsches Format
ausgewählt.

Messung kurzzeitiger
Verzerrungen

19 Short Time Distortion: Bar End
Not Found (Kurzzeitige Verzerrung:
Balkenende nicht gefunden)

Die Zeilennummer ist falsch
festgelegt, das Signal ist verzerrt,
oder es wurde ein falsches Format
ausgewählt.

Messung kurzzeitiger
Verzerrungen

20 Short Time Distortion: Invalid
results for Channel<x> (Kurzzeitige
Verzerrung: Ungültige Ergebnisse für
Kanal <x>)

Die Zeilennummer ist falsch
festgelegt, ungeeignetes
Eingangssignal oder falsche
Konfiguration.

Messung kurzzeitiger
Verzerrungen
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Warnmeldungen für die Option SD/HD (Fortsetzung)

Nummer Text Mögliche Ursachen
Eventuell betroffener
Vorgang

21 Sync Measurements Inconclusive
(Sync-Messungen ohne Ergebnis)

Das Gerät kann keine entsprechende
Synchronisation ermitteln, das
falsche Format ist ausgewählt, oder
das Signal ist verzerrt.

Messung der
Synchronisation

22 Sync Measurement: <n> Not Found
(Sync-Messung: <n> nicht gefunden)

Das Gerät kann keine entsprechende
Synchronisation finden.

Messung der
Synchronisation

23 2T pulse not found in luminance
component of signal (2T-Puls in
Luminanzkomponente des Signals
nicht gefunden)

Die Zeilennummer ist falsch
festgelegt, ungeeignetes
Eingangssignal oder falsche
Konfiguration.

Messung kurzzeitiger
Verzerrungen

24 Writing over file <filename> (Datei
<Dateiname> wird überschrieben)

Das Gerät überschreibt eine
vorhandene Datei.

Abrufen von
Einstellungen;
Generieren eines
Berichts

25 Sync Acquisition Problem:
(Problem bei der Erfassung der
Synchronisation:) Entweder das
Gerät kann kein Signal erzeugen,
oder die Signalpegel liegen außerhalb
des gültigen Bereichs.

Triggerung

Warnmeldungen für die Option VGA

Nummer Text Mögliche Ursachen
Eventuell betroffener
Vorgang

1 Sync edge locations questionable.
Make sure that the selected
format is correct. (Positionen der
Synchronisationsflanken zweifelhaft.
Vergewissern Sie sich, dass das
richtige Format ausgewählt wurde.)

Das Format ist falsch festgelegt. Messung von H Sync,
V Sync und V Timing

2 H Timing: Incorrect signal in Channel
<1–3>. Use Black-White-Black
signal. Sync edge locations
questionable. Make sure that the
selected format is correct. (H Timing:
Falsches Signal in Kanal <1–3>.
Verwenden Sie das Schwarz-Weiß-
Schwarz-Signal. Positionen der
Synchronisationsflanken zweifelhaft.
Vergewissern Sie sich, dass das
richtige Format ausgewählt wurde.)

Das Format ist falsch festgelegt. Messung von H Timing
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Warnmeldungen für die Option VGA (Fortsetzung)

Nummer Text Mögliche Ursachen
Eventuell betroffener
Vorgang

3 H Timing: Incorrect signal in Channel
<1–3>. Use Black-White-Black
signal. (H Timing: Falsches Signal
in Kanal <1–3>. Verwenden Sie das
Schwarz-Weiß-Schwarz-Signal.)

Das Schwarz-Weiß-Schwarz-Signal
wird nicht verwendet.

Messung von H Timing

4 Invalid Results: Acquisition Problem:
Either cannot trigger or the signal
levels are out of range or acquired
less than the requested samples.
(Ungültige Ergebnisse: Problem
bei der Erfassung: Entweder kann
kein Signal erzeugt werden, oder
die Signalpegel liegen außerhalb
des zulässigen Bereichs, oder es
wurden weniger als die angeforderten
Abtastwerte erfasst.)

Erfassung fehlgeschlagen: Trigger
fehlt, falsches Format oder andere
Ursache für die fehlgeschlagene
Erfassung des Signals.

Alle Messungen

5 Linearity: Signal Change: Channel
<x>: (Linearität: Signaländerung:
Kanal <x>:)

Stabilitätsproblem während der
kontinuierlichen Ausführung: Die
Rampe ist nicht mehr vorhanden,
oder die Anzahl der Stufen hat sich
geändert.

Messung der Linearität

6 Linearity: Signal Fidelity Problem:
Channel <x> Resolution mismatch:
Line A<x> bits, Line B <y> bits:
Steps not found (Problem mit der
Signalwiedergabe: Kanal <x>
Auflösungskonflikt: Zeile A <x>
Bits, Zeile B <y> Bits: Stufen nicht
gefunden)

Bei zweizeiligen Rampen (unterer
Bereich der Rampe in einer Zeile und
oberer Bereich der Rampe in der
zweiten Zeile) stimmt die Bitauflösung
der LSB-Treppenrampen nicht
überein, oder die Gesamtzahl der
Stufen entspricht nicht (2^n — 1).

Messung der Linearität

7 Linearity: Error occurred in switch
accessory (Linearität: Fehler in
Austauschzubehör)

Die RGBHV-Messschnittstellenein-
heit reagiert nicht ordnungsgemäß.

Messung der Linearität

8 Sync edge locations questionable.
Make sure that the selected
format is correct. (Positionen der
Synchronisationsflanken zweifelhaft.
Vergewissern Sie sich, dass das
richtige Format ausgewählt wurde.)

Das Format ist falsch festgelegt. Messung von
Farbbalken,
Videokanalkonflikt,
Kanal-zu-Kanal-
Zeitversatz,
Luminanzstufen,
Videokanalkonflikt,
V Sync, V Timing und
Video-Transiente.
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Warnmeldungen für die Option VGA (Fortsetzung)

Nummer Text Mögliche Ursachen
Eventuell betroffener
Vorgang

9 Color Bars: Yellow/Cyan/Green/Ma-
genta/Red/Blue/Black Bar
not found. (Farbbalken:
Balken Gelb/Zyan/Grün/Ma-
genta/Rot/Blau/Schwarz nicht
gefunden.)

Das Farbbalkensignal wird nicht
verwendet.

Messung von
Farbbalken

10 Ch-Ch Skew: Incorrect signal in
Channel <1–3>. Use the Alternate
White and Black bar signal. (Versatz
zwischen Kanälen: Falsches Signal
in Kanal <1–3>. Verwenden Sie das
Signal mit alternierenden weißen und
schwarzen Balken.)

Das Format ist falsch festgelegt. Messung des Versatzes
zwischen Kanälen

11 Ch-Ch Skew: Incorrect signal in
Channel <1–3>. Use the Alternate
White and Black bar signal.
(Luminanzstufen: Falsches Signal
in Kanal <1–3>. Verwenden Sie das
Signal mit alternierenden weißen und
schwarzen Balken.)

Alternierendes Weiß-Schwarz-Signal
wird nicht verwendet.

Messen von
Luminanzstufen

12 Video Transient: Incorrect signal
in Channel <1–3>. Use the
Alternate White & Black bar signal.
(Video-Transiente: Falsches Signal
in Kanal <1–3>. Verwenden Sie das
Signal mit alternierenden weißen und
schwarzen Balken.)

Alternierendes Weiß-Schwarz-Signal
wird nicht verwendet.

Messen von
Video-Transienten

13 H Sync Jitter: Sync edge locations
questionable. Make sure that
the selected format is correct.
(H Sync Jitter: Positionen der
Synchronisationsflanken zweifelhaft.
Vergewissern Sie sich, dass das
richtige Format ausgewählt wurde.)

Das Format ist falsch festgelegt. Messung von
H Sync-Jitter

14 Noise: Invalid results for some
channels. (Rauschen: Ungültige
Ergebnisse für einige Kanäle.)

Die Zeilennummer ist falsch
festgelegt, ungeeignetes
Eingangssignal oder falsche
Konfiguration.

Messung von Rauschen

15 Ch-Ch Mismatch: Incorrect signal in
Channel <1–3>. Use the 32–step
Staircase signal in true color mode.
(Konflikt zwischen Kanälen: Falsches
Signal in Kanal <1–3>. Verwenden
Sie das 32-stufige Treppensignal im
True Color-Modus.

Treppensignal mit 32 Stufen wird
nicht verwendet

Messung von Konflikten
zwischen Kanälen
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Fehlermeldungen

Nummer Text Mögliche Ursachen
Eventuell betroffener
Vorgang

1 File Name Error: File doesn’t exist:
<filename> (Dateinamenfehler: Datei
ist nicht vorhanden: <Dateiname>)

Die ausgewählte VMSET-Datei
ist nicht vorhanden. (Sie müssen
den vollständigen Pfad angeben,
wenn sich die Datei nicht im Ordner
C:\VMApps\ befindet.)

Abrufen von
Einstellungen

2 Cannot write file: file already
exists: <filename> (Datei kann nicht
geschrieben werden: Datei ist bereits
vorhanden: <Dateiname>)

Der <Dateiname> muss geändert
werden, damit die Datei gespeichert
werden kann.

Speichern von
Einstellungen;
Generieren eines
Berichts

3 File Name Error. Invalid character(s)
in file name (Dateinamenfehler.
Ungültige Zeichen in Dateiname)

Ungültige Zeichen im Dateinamen.
Die folgenden Zeichen sind ungültig:
“|”, “:”, “/”, “,”, “<“, „>“, „*“, „\“ und „?“.

Speichern von
Einstellungen;
Generieren eines
Berichts

4 No Measurement Selected (Es wurde
keine Messung ausgewählt)

Im Menü „Configuration >
Measurements“ (Konfiguration
> Messungen) wurden keine
Messungen ausgewählt.

Ausführen einer
Messung; Generieren
eines Berichts

5 Cannot create Report. Not all selected
measures have been Run (Bericht
kann nicht erstellt werden. Nicht alle
ausgewählten Messungen wurden
ausgeführt.)

Sie müssen eine Messung ausführen
und warten, bis diese abgeschlossen
ist, bevor ein Bericht generiert werden
kann.

Generieren von
Berichten.

6 Invalid Filename (Ungültiger
Dateiname)

Die Datei ist nicht vorhanden, oder
der Pfad ist falsch. Sie müssen
den vollständigen Pfad angeben,
wenn sich die Datei nicht im Ordner
C:\VMApps befindet.

RecallSettings;
SaveSettings;
ReportGenerate (nur
wenn über GPIB
aufgerufen)

7 Invalid Argument (Ungültiges
Argument)

Für den betreffenden GPIB-Befehl
wurde ein falsches Argument
verwendet.

Alle GPIB-Befehle

8 Command Overflow (Befehlsüberlauf) Die GPIB-Befehle wurden zu
schnell gesendet. Verlängern Sie
die Verzögerung zwischen zwei
Befehlen, um dieses Problem
zu vermeiden (Intervalle von
100 Millisekunden empfohlen), oder
verwenden Sie Handshaking mit
OPComplete.

Beim zu schnellen
Senden von
GPIB-Befehlen.
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Fehlermeldungen (Fortsetzung)

Nummer Text Mögliche Ursachen
Eventuell betroffener
Vorgang

9 Command Missed (Befehl fehlt) Dieser Fehler gibt an, dass ein in der
letzten Sekunde gesendeter Befehl
eventuell nicht verarbeitet wurde.
Deshalb sollten Sie zurück zu einer
aktuellen (bekannten) Konfiguration
wechseln und die letzten Befehle
erneut senden.

Senden eines
GPIB-Befehls

10 Error occurred in configuring MIU
(Fehler bei der Konfiguration der
Messschnittstelleneinheit)

Falsche serielle Verbindung zur
Messschnittstelleneinheit, oder
eines der CH1/-CH2-/CH3-/CH4-
Anschlusskabel ist vom System der
Serie VM getrennt.

Ausführen von Mes-
sungen mit Hilfe der
Messschnittstellenein-
heit.
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Einfache Farbbalkenmessung – Optionen SD/HD
Amplitudenmessungen werden normalerweise mit dem Farbbalkenprüfsignal ausgeführt, das die RGB-Komponenten
ein- und ausschaltet, sodass alle acht möglichen Farbkombinationen (Weiß, Gelb, Zyan, Grün, Magenta, Rot, Blau und
Schwarz) entstehen können. Es gibt verschiedene Formen des Farbbalkenprüfsignals, von denen jedes einen maximalen
dynamischen Bereich von 700 mV = 100 % oder 75 % bei einer RGB-Amplitude von 525 mV verwendet. In den folgenden
Tabellen sind die Amplitudenbereiche für die Komponente Y′P′bP′r für die verschiedenen Standards von 100 %- und
75 %-Farbbalken angegeben.

Amplitudenbereiche für verschiedene 100 %-Farbbalkensignalformate
480p/576p 1080/720

Farb-
balken

R
(mV)

G
(mV)

B
(mV)

Y
(mV)

Pb
(mV)

Pr
(mV)

Y
(mV)

Pb
(mV)

Pr
(mV)

Weiß 700 700 700 700.0 0.0 0.0 700.0 0.0 0.0
Gelb 700 700 0 620.2 -349.8 56.9 649.5 -350.0 32.1
Zyan 0 700 700 490.7 118.0 -349.9 551.2 80.2 -350.0
Grün 0 700 0 410.9 -231.7 -293.0 500.6 -269.8 -317.9
Magenta 700 0 700 289.1 231.7 293.0 199.4 269.8 317.9
Rot 700 0 0 209.3 -118.0 349.9 148.8 -80.2 350.0
Blau 0 0 700 79.8 349.8 -56.9 50.5 350.0 -32.1
Schwarz 0 0 0 0.0 0.0 0.0 0.0 0.0 0.0

Amplitudenbereiche für verschiedene 75 %-Farbbalkensignalformate
480p/576p 1080/720

Farb-
balken

R
(mV)

G
(mV)

B
(mV)

Y
(mV)

Pb
(mV)

Pr
(mV)

Y
(mV)

Pb
(mV)

Pr
(mV)

Weiß 700 700 700 700.0 0.0 0.0 700.0 0.0 0.0
Gelb 525 525 0 465.2 -262.3 42.7 487.1 -262.5 24.1
Zyan 0 525 525 368.0 88.5 -262.4 413.4 60.2 -262.5
Grün 0 525 0 308.2 -173.8 -219.7 375.5 -202.3 -238.4
Magenta 525 0 525 216.8 173.8 219.7 149.5 202.3 238.4
Rot 525 0 0 157.0 -88.5 262.4 111.6 -60.2 262.5
Blau 0 0 525 59.9 262.3 -42.7 37.9 262.5 -24.1
Schwarz 0 0 0 0.0 0.0 0.0 0.0 0.0 0.0

Je nach dem zu testenden Gerät ist eine Abweichung der tatsächlichen Werte zulässig. Beispielsweise können von den
progressiven Ausgängen von DVD-Playern Einstellungen für die zugehörigen Ausgänge eingeführt werden, die die
Gesamtmessergebnisse beeinflussen können. Abweichungen der Ebene der Komponenten können unterschiedliche
Farbtöne und Sättigungen des angezeigten Bildes bewirken. Das Farbbalkenprüfsignal ermöglicht es Ihnen,
Verstärkungsabweichungen zwischen den Kanälen zu bestimmen und sicherzustellen, dass das Signal nicht verzerrt ist.
Dies könnte eine starke Signalamplitudenbegrenzung zur Folge haben.
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Das Tektronix-Matrixmuster verwendet ein 100 %-Farbbalkensignal, um den vollen dynamischen Bereich jeder Komponente
zu testen. Das Farbbalkenmuster befindet sich nahe dem oder im oberen Bereich des Matrixmusters; die Zeilennummern,
an denen es auftritt, sind für jeden Standard unterschiedlich. Die angegebenen Zeilennummern sind die Standardwerte
zum Generieren der Testmatrix, aber bei einigen zu prüfenden Systemen verschieben sich möglicherweise die Zeilen
im Bild an eine andere Position.

Format 1080i 720p 480p 576p
Zeile 21 - 84 26 - 153 43 - 106 45 - 108
Quelle 584 - 647

Das System der Serie VM führt die Farbbalkenmessungen aus, indem zunächst die relative Amplitude für jeden der
drei Kanäle ermittelt wird. Acht Amplitudenmessungen werden auf jedem Kanal vorgenommen, das sind insgesamt
24 Messungen in weniger als einer halben Sekunde. Anhand der folgenden Schritte werden die typischen Messergebnisse
für ein 1080i-Signal gezeigt. Die Amplitude für jede Balkenhöhe wird in Bezug auf den Schwarzschalter gemessen.
Amplituden werden mit Werten von gemittelten Signalen in jedem ermittelten Balken berechnet. Deshalb ist es wichtig
sicherzustellen, dass das Video vollständig im Erfassungsfenster des Instruments angezeigt wird, wenn am Gerät manuelle
Einstellungen vorgenommen wurden.

1. Schalten Sie das Gerät ein.

2. Wählen Sie Analyze > VM HD and SD
Video V3.2 (Analysieren > VM HD- und
SD-Video V3.2).

3. Wählen Sie in der Anwendung
des Systems der Serie VM
File > Recall Default Setup (Datei >
Grundeinstellungen abrufen) aus, um
alle Einstellungen auf die werkseitigen
Standardwerte zurückzusetzen.
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4. Legen Sie ein Signal an die Eingänge
an. (Siehe Seite 9, Verbinden von
Eingangssignalen.)

5. Stellen Sie das Eingangssignalformat
ein. (Siehe Seite 32, Festlegen des
Eingangssignalformats – Optionen
SD/HD.)

6. Wählen Sie Configuration >
Measurements (Konfiguration >
Messungen) aus.
Beachten Sie, dass in der
Standardeinstellung „Color Bars“
(Farbbalken) ausgewählt ist.

7. Klicken Sie auf die Schaltfläche „Run“
(Ausführen).

Wenn die Messungen abgeschlossen
sind, wird der Ergebnisbildschirm
angezeigt.

Einfache Farbbalkenmessung – Option VGA
Amplitudenmessungen werden normalerweise mit dem Farbbalkenprüfsignal ausgeführt, das die RGB-Komponenten
ein- und ausschaltet, sodass alle acht möglichen Farbkombinationen (Weiß, Gelb, Zyan, Grün, Magenta, Rot, Blau und
Schwarz) entstehen können. Es gibt verschiedene Formen des Farbbalkenprüfsignals, von denen jedes einen maximalen
dynamischen Bereich von 700 mV = 100 % oder 75 % bei einer RGB-Amplitude von 525 mV verwendet. In der folgenden
Tabelle wird die Amplitude für das RGB-Signal bei 100 % und 75 % dargestellt.
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Amplitude für 100 %-Farbbalkensignal
Farbbalken R (mV) G (mV) B (mV)
Weiß 700 700 700
Gelb 700 700 0
Zyan 0 700 700
Grün 0 700 0
Magenta 700 0 700
Rot 700 0 0
Blau 0 0 700
Schwarz 0 0 0

Amplitude für 75 %-Farbbalkensignalformate
Farbbalken R (mV) G (mV) B (mV)
Weiß 700 700 700
Gelb 525 525 0
Zyan 0 525 525
Grün 0 525 0
Magenta 525 0 525
Rot 525 0 0
Blau 0 0 525
Schwarz 0 0 0

Das Tektronix-Matrixmuster verwendet ein 100 %-Farbbalkensignal, um den vollen dynamischen Bereich der einzelnen
Komponenten zu testen. Das Farbbalkenmuster befindet sich nahe dem oder im oberen Bereich des Matrixmusters;
die Zeilennummern, an denen es auftritt, sind für jedes Format unterschiedlich. In den folgenden Tabellen sind die
Zeilennummern aufgeführt, in denen sich die unterschiedlichen Muster im Matrixsignal bei einer Aktualisierungsrate von
60 Hz befinden. Bei anderen Aktualisierungsraten kann die tatsächliche Ausgangszeilennummer deutlich von der Rate
von 60 Hz abweichen. Um die Position der aktiven Videozeilennummer für ein bestimmtes Muster bei einer anderen
Aktualisierungsrate anzeigen zu lassen, suchen Sie die Microsoft Excel-Datei „Matrix.xls“, die sich auf der Software-CD für
das System der Serie VM befindet. In dieser Datei sind die tatsächlichen aktiven Videozeilennummern für alle unterstützten
Aktualisierungsraten aufgelistet.

Position der aktiven Videozeilennummer von Mustern bei einer Aktualisierungsrate von 60 Hz (640 x 480
bis 1280 x 1024)
Muster 640 x 480 800 x 600 1024 x 768 1280 x 1024
Hälfte weiß und Hälfte schwarz 36 – 83 28 – 87 36 – 112 42 – 143
Neun Farbbalken 84 – 179 88 – 207 113 – 265 144 – 348
32 Stufen 180 – 227 208 – 267 266 – 342 349 – 450
Alternierend Weiß und Schwarz 228 – 275 268 - 327 343 - 419 451 -552
Schwarz/weiß/schwarz 276 – 323 328 – 387 420 – 496 553 – 654
Vollweiß 324 – 371 388 – 447 497 – 572 655 – 756
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Position der aktiven Videozeilennummer von Mustern bei einer Aktualisierungsrate von 60 Hz (640 x 480
bis 1280 x 1024) (Fortsetzung)

Muster 640 x 480 800 x 600 1024 x 768 1280 x 1024
Rampe 372 – 467 448 – 567 573 – 726 757 – 962
Hälfte weiß und Hälfte schwarz 468 – 515 568 – 627 727 – 803 963 – 1065

Position der aktiven Videozeilennummer von Mustern bei einer Aktualisierungsrate von 60 Hz (1600 x 1024
bis 1900 x 1200)
Muster 1600 x 1024 1600 x 1200 1920 x 1080 1920 x 1200
Hälfte weiß und Hälfte schwarz 36 – 132 50 – 169 38 – 140 43 – 162
Neun Farbbalken 143 – 337 170 – 409 150 – 356 163 – 402
Treppe 347 – 439 410 – 529 366 – 464 403 – 522
Alternierend Weiß und Schwarz 450 – 542 530 – 649 474 – 572 523 – 642
Schwarz/weiß/schwarz 552 – 644 650 – 769 582 – 680 643 – 762
Vollweiß 655 – 747 770 – 889 690 – 788 763 – 882
Rampe 757 – 951 890 – 1129 798 – 1004 883 – 1122
Hälfte weiß und Hälfte schwarz 962 – 1059 1130 – 1249 1014 – 1117 1123 – 1242

Position der aktiven Videozeilennummer von Mustern bei einer Aktualisierungsrate von 60 Hz (1920 x 1440
bis 2048 x 2048)
Muster 1920 x 1440 2048 x 1536 2048 x 2048
Hälfte weiß und Hälfte schwarz 50 – 193 53 – 198 71 – 265
Neun Farbbalken 194 – 481 213 – 505 285 – 674
Treppe 482 – 625 520 – 659 695 – 879
Alternierend Weiß und Schwarz 626 – 769 674 – 812 899 – 1084
Schwarz/weiß/schwarz 770 – 913 828 – 966 1104 – 1289
Vollweiß 914 – 1057 981 – 1120 1309 – 1493
Rampe 1058 – 1345 1135 – 1427 1514 – 1903
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Muster 1920 x 1440 2048 x 1536 2048 x 2048
Hälfte weiß und Hälfte schwarz 1346 – 1489 1442 – 1588 1923 – 2118

Das System der Serie VM führt die Farbbalkenmessungen aus, indem zunächst die relative Amplitude für jeden der
drei Kanäle ermittelt wird. Acht Amplitudenmessungen werden auf jedem Kanal vorgenommen, das sind insgesamt
24 Messungen in weniger als einer halben Sekunde. Anhand der folgenden Schritte werden die typischen Messergebnisse
für ein 1024 x 768-Signal gezeigt. Die Amplitude für jede Balkenhöhe wird in Bezug auf den Schwarzschalter gemessen.
Amplituden werden mit Werten von gemittelten Signalen in jedem ermittelten Balken berechnet. Deshalb ist es wichtig
sicherzustellen, dass das Video vollständig im Erfassungsfenster des Instruments angezeigt wird, wenn am Gerät manuelle
Einstellungen vorgenommen wurden.

1. Schalten Sie das Gerät ein.

2. Wählen Sie Analyze > VM VGA Video
V3.2 (Analysieren > VM VGA-Video
V3.2).

3. Wählen Sie in der Anwendung
des Systems der Serie VM File
> Recall Default Setup (Datei >
Grundeinstellungen abrufen) aus, um
alle Einstellungen auf die werkseitigen
Standardwerte zurückzusetzen.

4. Legen Sie ein Signal an die Eingänge
an. (Siehe Seite 9, Verbinden von
Eingangssignalen.)

5. Wählen Sie das Eingangssignalformat
aus. (Siehe Seite 34, Festlegen des
Eingangssignalformats – Option VGA.)
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6. Wählen Sie Configuration >
Measurements (Konfiguration >
Messungen) aus.
Beachten Sie, dass in der
Standardeinstellung „Color Bars“
(Farbbalken) ausgewählt ist.

7. Klicken Sie auf die Schaltfläche „Run“
(Ausführen).

Wenn die Messungen abgeschlossen
sind, wird der Ergebnisbildschirm
angezeigt.
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Anzeige relativ zu Referenzfarbbalkenmessungen
Das System der Serie VM zeigt die Messergebnisse auf zweierlei Weise an: wie gemessen und in Bezug auf einen
Referenzwert. Der relative Wert wird durch Subtraktion des gemessenen Werts von einem Referenzwert berechnet. Um
Messergebnisse in Bezug auf einen Referenzwert anzeigen zu lassen, müssen Sie Enable Relative Results (Relative
Ergebnisse aktivieren) auf der Registerkarte Reference & Limits (Referenz & Grenzen) des Konfigurationsbildschirms
auswählen. Referenzwerte werden in speziellen Textdateien mit durch Komma unterteilten Werten (CSV) angegeben. Das
System der Serie VM enthält einige Toleranzmaskendateien, die Sie bearbeiten können, sodass Sie die Referenzwerte Ihrer
Anwendung entsprechend angeben können.

1. Schalten Sie das Gerät ein.

2. Wählen Sie Analyze > VM HD and
SD Video V3.2 (Datei > VM HD- und
SD-Video V3.2) oder VM VGA Video
V3.2 (VM VGA-Video V3.2).

3. Wählen Sie in der Anwendung
des Systems der Serie VM
File > Recall Default Setup (Datei >
Grundeinstellungen abrufen) aus, um
alle Einstellungen auf die werkseitigen
Standardwerte zurückzusetzen.

4. Legen Sie ein Signal an die Eingänge
an. (Siehe Seite 9, Verbinden von
Eingangssignalen.)

5. Wählen Sie das Eingangssignalformat
aus. (Siehe Seite 32, Festlegen des
Eingangssignalformats – Optionen
SD/HD.) (Siehe Seite 34, Festlegen des
Eingangssignalformats – Option VGA.)
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6. Wählen Sie Configuration > Reference
& Limits (Konfiguration > Referenz &
Grenzen) aus.

7. Aktivieren Sie das Kontrollkästchen
Enable Relative Result Display
(Anzeige von relativen Ergebnissen
aktivieren).
In der Standardeinstellung wählt die
Anwendung des Systems der Serie VM
aus den verfügbaren Toleranzmasken
automatisch eine zum ausgewählten
Signalformat passende Referenzdatei
aus.

8. Klicken Sie auf die Schaltfläche „Run“
(Ausführen).

Wenn die Messungen abgeschlossen
sind, wird der Ergebnisbildschirm
angezeigt. Beachten Sie, dass nun
die Registerkarten „Relative“ (Relativ)
und „Reference“ (Referenz) ausgewählt
werden können.

Option SD/HD

60 Schnellstart-Benutzerhandbuch für Videomesssysteme der Serie VM



Anwendungen

Option VGA

9. Wählen Sie die Registerkarte Reference
(Referenz) aus, um die Referenzwerte
zum Berechnen der relativen Werte
anzeigen zu lassen.

Option SD/HD
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Option VGA

10. Wählen Sie die Registerkarte Relative
(Relativ) aus, um die berechneten
relativen Werte anzeigen zu lassen.
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11. Wählen Sie die Optionsschaltfläche
% aus, um die prozentuale Differenz
zwischen dem gemessenen Wert und
dem Referenzwert anzeigen zu lassen.

Option SD/HD

Option VGA
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Anzeigen von Farbbalkenmessungen mit Grenzwertprüfung
Das System der Serie VM kann Messergebnisse im Vergleich zu einem Grenzwert und mit einer Pass/Fehler-Angabe
anzeigen. Wie bei den relativen Messungen wird der Grenzwert in einer Textdatei mit durch Komma getrennten Werten
(CSV-Format) angegeben. Das System der Serie VM enthält einige Toleranzmaskendateien, die Sie bearbeiten können,
sodass Sie die Grenzwerte Ihrer Anwendung entsprechend angeben können. Grenzwerte bestehen aus einem Maximalwert
und einem Minimalwert. Messwerte, die zwischen dem maximalen und dem minimalen Grenzwert liegen, haben die
Grenzwertprüfung bestanden. Messwerte, die oberhalb des maximalen oder unterhalb des minimalen Grenzwerts liegen,
haben die Grenzwertprüfung nicht bestanden.

1. Schalten Sie das Gerät ein.

2. Wählen Sie Analyze > VM HD and
SD Video V3.2 (Datei > VM HD- und
SD-Video V3.2) oder VM VGA Video
V3.2 (VM VGA-Video V3.2).

3. Wählen Sie File > Recall Default
Setup (Datei > Grundeinstellungen
abrufen) aus, um alle Einstellungen
auf die werkseitigen Standardwerte
zurückzusetzen.

Option SD/HD

Option VGA

4. Legen Sie ein Signal an die Eingänge
an. (Siehe Seite 9, Verbinden von
Eingangssignalen.)
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5. Wählen Sie das Eingangssignalformat
aus. (Siehe Seite 8, Voraussetzungen
für Eingangsverbindungen
– Optionen SD/HD.) (Siehe
Seite 8, Voraussetzungen für
Eingangsverbindungen – Option
VGA.)

6. Wählen Sie Configuration > Reference
& Limits (Konfiguration > Referenz &
Grenzen) aus.

Option SD/HD

Option VGA

7. Wählen Sie Enable Limit Testing
(Grenzwertprüfung aktivieren) aus.
In der Standardeinstellung wählt
die Anwendung VM5000 aus
den verfügbaren Toleranzmasken
automatisch eine zum ausgewählten
Signalformat passende Grenzwertdatei
aus.

Option SD/HD

Option VGA

8. Klicken Sie auf die Schaltfläche „Run“
(Ausführen).
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Wenn die Messungen abgeschlossen
sind, wird der Ergebnisbildschirm
angezeigt. Beachten Sie, dass nun
die Registerkarte „Limits“ (Grenzwerte)
ausgewählt werden kann.
Wenn die Grenzwertprüfung aktiviert ist,
werden die Ergebnisse in grün oder rot
formatiertem Text angezeigt. Grüner Text
bedeutet, dass die Prüfung bestanden
wurde (der Messwert hat die Grenzwerte
nicht überschritten). Roter Text bedeutet,
dass die Prüfung nicht bestanden wurde
(der Messwert hat den maximalen
Grenzwert überschritten bzw. den
minimalen Grenzwert unterschritten).

Option SD/HD

Option VGA
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9. Wählen Sie die Registerkarte Limits
(Grenzwerte) aus, um die verwendeten
Grenzwerte anzeigen zu lassen.
Wählen Sie entweder min oder max
aus, um die für die minimal und maximal
zulässigen Werte angegebenen Grenzen
anzeigen zu lassen.

Option SD/HD

Option VGA
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Grenzwertprüfung mit zwei Messungen
Das System der Serie VM kann Grenzwertprüfungen mit mehr als jeweils einer Messung vornehmen.

1. Schalten Sie das Gerät ein.

2. Wählen Sie Analyze > VM HD and
SD Video V3.2 (Datei > VM HD- und
SD-Video V3.2) oder VM VGA Video
V3.2 (VM VGA-Video V3.2).

Option SD/HD

3. Wählen Sie File > Recall Default
Setup (Datei > Grundeinstellungen
abrufen) aus, um alle Einstellungen
auf die werkseitigen Standardwerte
zurückzusetzen.

4. Legen Sie ein Signal an die Eingänge
an. (Siehe Seite 9, Verbinden von
Eingangssignalen.)

5. Wählen Sie das Eingangssignalformat
aus. (Siehe Seite 32, Festlegen des
Eingangssignalformats – Optionen
SD/HD.) (Siehe Seite 34, Festlegen des
Eingangssignalformats – Option VGA.)
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6. Wählen Sie Configuration > Reference
& Limits (Konfiguration > Referenz &
Grenzen) aus.

Option SD/HD

Option VGA

7. Wählen Sie Enable Limit Testing
(Grenzwertprüfung aktivieren) aus.
In der Standardeinstellung wählt
die Anwendung VM5000 aus
den verfügbaren Toleranzmasken
automatisch eine zum ausgewählten
Signalformat passende Grenzwertdatei
aus.

Option SD/HD

Option VGA

8. Klicken Sie auf die Registerkarte
Measurements (Messungen), um die
auszuführende Messung auszuwählen.
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9. Wählen Sie zwei Messungen aus:

Option SD/HD: Aktivieren Sie Color
Bars (Farbbalken) und H Sync
(Synchronisation).

Option SD/HD

Option VGA: Aktivieren Sie Color
Bars (Farbbalken) und Luma Levels
(Luminanzstufen).

Option VGA

10. Klicken Sie auf die Schaltfläche „Run“
(Ausführen).

Wenn die Messungen beginnen, wird der
Bildschirm für den Messstatus angezeigt.
Wenn die Messungen abgeschlossen
sind, wird für die ausgewählten
Messungen „Pass“ (Bestanden) oder
„Fail“ (Fehler) angezeigt.

Option SD/HD
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Option VGA

11. Um die Ergebnisse für die einzelnen
ausgewählten Messungen anzuzeigen,
klicken Sie auf das Menü Results
(Ergebnisse), und wählen Sie eine der
Messungen aus.
Der Ergebnisbildschirm für die
ausgewählte Messung wird angezeigt.

Option SD/HD
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Option VGA

12. Um die Ergebnisse für die andere
ausgewählte Messung anzuzeigen,
klicken Sie auf das Menü Results
(Ergebnisse), und wählen Sie die andere
Messung aus.

Option SD/HD
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Option VGA
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Ausführen von Messungen über mehrere Zeilen
Bei Messungen mit dem System der Serie VM wird mit der Zeilennummer angegeben, an welcher Stelle (bzw. wann)
die Messung vorgenommen wird. (Wenn Sie die Luminanzstufe messen möchten, müssen Sie sicherstellen, dass die
Messung innerhalb des aktiven Videobereichs des Signals vorgenommen wird.) Gelegentlich müssen Sie eine Messung
über mehrere Zeilen ausführen. (Beispielsweise müssen Sie möglicherweise überprüfen, ob die Pegel vom oberen Ende
bis zum unteren Ende des Bildschirms konsistent ist.) Verwenden Sie dazu die Einstellung „Multi Lines“ (Mehrere Zeilen)
unter „Line Select“ (Zeilenauswahl) auf der Registerkarte „Operation“ (Betrieb). Jede Messung erfordert ein passendes
Signalmuster in einer festgelegten Zeile des eingehenden Videosignals. Dieser Zeilennummer-Einrichtungsparameter wird
über das Eingabefeld „Line Number“ (Zeilennummer) in der Ergebnisanzeige der Messung konfiguriert. Das Signalmuster ist
normalerweise in mehreren Zeilen des eingehenden Signals verfügbar. Die Messung kann durch Angabe einer beliebigen
dieser einzelnen Zeilen ausgeführt werden.

HINWEIS. Im „Multiple Lines“ (Mehrere Zeilen)-Modus stehen nicht alle Messungen zur Verfügung. Die Einstellungen
„Setup Only“ (Nur Setup), „Run Only“ (Nur ausführen) und „Continuously“ (Kontinuierlich) (im Fenster für Vorgänge) sind im
„Multiple Lines“ (Mehrere Zeilen)-Modus nicht verfügbar.

Wenn das Gerät sich im „Multiple Lines“ (Mehrere Zeilen)-Modus befindet, werden Messungen nacheinander auf jede
Zeilennummer des für die ausgewählten Messungen festgelegten Bereichs ausgeführt. Die Ergebnisse für die einzelnen
Zeilen werden gemittelt und dann in der Ergebnisanzeige der Messung dargestellt. Die für die ausgewählte Messung
festgelegten Zeilennummern werden im Feld „Line Number“ (Zeilennummer) in der entsprechenden Ergebnisanzeige
dargestellt. Wenn der Betriebsmodus auf „Once & Report“ (Einmal und Bericht) festgelegt ist, generiert das Gerät eine
Berichtsdatei im ausgewählten Format (RTF, PDF oder CSV), die die Ergebnisse für alle einzelnen Zeilennummern des
gewählten Bereichs und die für den gesamten Bereich berechneten Mittelwerte enthält.

1. Schalten Sie das Gerät ein.

2. Wählen Sie Analyze > VM HD and
SD Video V3.2 (Datei > VM HD- und
SD-Video V3.2) oder VM VGA Video
V3.2 (VM VGA-Video V3.2).
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3. Wählen Sie in der Anwendung
des Systems der Serie VM File
> Recall Default Setup (Datei >
Grundeinstellungen abrufen) aus, um
alle Einstellungen auf die werkseitigen
Standardwerte zurückzusetzen.

4. Legen Sie ein Signal an die Eingänge
an. (Siehe Seite 9, Verbinden von
Eingangssignalen.)

5. Wählen Sie Configuration >
Format (Konfiguration > Format),
und nehmen Sie die gewünschten
Formateinstellungen vor.

6. Wählen Sie Configuration > Operations
(Konfiguration > Vorgänge) aus.

Option VGA

7. Klicken Sie im Bereich „Line Select“
(Zeilenauswahl) auf Multi Lines
(Mehrere Zeilen).

Option SD/HD

Option VGA
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8. Zur Angabe der Messungen und der
Zeilen, auf denen die Messungen
genommen werden sollen, wählen
Sie die Registerkarte Measurements
(Messungen).

Option SD/HD

Option VGA

Für jede Messung sind zwei
Eingabefelder vorhanden: „Start
Line“ (Anfangszeile) und „End Line“
(Endzeile). Verwenden Sie diese
zwei Felder, um den Zeilenbereich
anzugeben, über den die Messung
erfolgen soll.

9. Um eine auszuführende Messung
auszuwählen, aktivieren Sie das
Kontrollkästchen neben der Messung.

Option VGA

10. Geben Sie die Zeilennummern in die
Felder Start Line (Anfangszeile) und
End Line (Endzeile) ein.

Option VGA
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Wenn der Betriebsmodus auf „Once
& Report“ (Einmal und Bericht)
festgelegt ist, generiert das Gerät
nach Abschluss der Messungen einen
Bericht. Standardmäßig generiert das
Gerät automatisch einen eindeutigen
Dateinamen für die Berichtsdatei. Sie
können jedoch einen Dateinamen und
einen Speicherort angeben.

11. So geben Sie die Parameter der Datei
an, in der die Ergebnisse gespeichert
werden:

Klicken Sie auf Utilities
(Dienstprogramme) > Generate
Report (Bericht generieren).

Daraufhin wird das Fenster zum
Generieren eines Berichts angezeigt.

12. Klicken Sie auf Browse (Durchsuchen),
um den Dateinamen und den Speicherort
zu ändern. Daraufhin wird das Dialogfeld
Save (Speichern) angezeigt.

13. Geben Sie den Dateinamen ein,
oder navigieren Sie in das gewünschte
Verzeichnis, in dem die Datei gespeichert
werden soll.
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14. Wählen Sie das Format des Berichts aus
den unter Files of type (Dateien vom
Typ) aufgelisteten Formaten aus.

15. Klicken Sie auf Save (Speichern).

16. Wenn Sie eine Bildschirmaufnahme
des Signals im Bericht speichern
möchten, wählen Sie Configuration
(Konfiguration) > Operation (Betrieb)
aus, um das Fenster für Vorgänge
anzuzeigen. Wählen Sie Embed
Screen Capture (Bildschirmaufnahme
einbetten) unter RTF Report Mode
(RTF-Berichtsmodus).

Option VGA

17. Klicken Sie auf die Schaltfläche Run
(Ausführen), um die Messungen
auszuführen.
Nachdem Sie auf Run (Ausführen)
geklickt haben, wird die Ergebnisseite
für die erste ausgewählte Messung auf
dem System der Serie VM angezeigt,
und die Messungen beginnen. Die
angezeigte Zeilennummer wird mit jeder
abgeschlossenen Messung größer, bis
die Messung für alle angegebenen Zeilen
ausgeführt wurde. Der Vorgang wird für
jede ausgewählte Messung wiederholt.
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18. Um die Messergebnisse anzuzeigen,
öffnen Sie die Berichtsdatei mit der
entsprechenenden Anwendung.

Anzeigen des Eingangssignals als Bild
Das System der Serie VM kann das Eingangssignal als Bild anzeigen.

1. Schalten Sie das Gerät ein.
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2. Wählen Sie Analyze > VM HD and
SD Video V3.2 (Datei > VM HD- und
SD-Video V3.2) oder VM VGA Video
V3.2 (VM VGA-Video V3.2).

3. Legen Sie ein Signal an die Eingänge
an. (Siehe Seite 9, Verbinden von
Eingangssignalen.)

4. Klicken Sie auf die Schaltfläche
mit dem Bild. Daraufhin wird das
Videomonitorfenster angezeigt.

5. Klicken Sie auf die Schaltfläche zum
Maximieren, um das Bild auf den
gesamten Bildschirm zu vergrößern.
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Anzeige des Eingangssignals in einem Vektorskop-Fenster – Nur Optionen
SD/HD

Mit dem System der Serie VM kann das Eingangssignal in einem Vektorskop-Fenster angezeigt werden, sodass Sie sofort
den Farbbereich des Signals sehen können.

1. Schalten Sie das Gerät ein.

2. Wählen Sie Analyze > VM HD and SD
Video V3.2 (Analysieren > VM HD- und
SD-Video V3.2).

3. Legen Sie ein Signal an die Eingänge
an. (Siehe Seite 9, Verbinden von
Eingangssignalen.)

4. Klicken Sie auf die Schaltfläche
„Vectorscope“ (Vektorskop).
Daraufhin wird das Videomonitor-
Anzeigefenster angezeigt.
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5. Klicken Sie auf die Schaltfläche zum
Maximieren, um die Vektorskopanzeige
auf den gesamten Bildschirm zu
vergrößern.
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